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Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the 
software is customarily provided to the 
public. Accordingly, Keysight provides the 
Software to U.S. government customers 
under its standard commercial license, 
which is embodied in its End User License 
Agreement (EULA), a copy of which can be 
found at 
http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 
the exclusive authority by which the U.S. 

government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that 
Keysight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish to, 
or otherwise provide, the government 
rights in excess of these rights customarily 
provided to the public to use, modify, 
reproduce, release, perform, display, or 
disclose commercial computer software or 
commercial computer software 
documentation. No additional government 
requirements beyond those set forth in the 
EULA shall apply, except to the extent that 
those terms, rights, or licenses are 
explicitly required from all providers of 
commercial computer software pursuant to 
the FAR and the DFARS and are set forth 
specifically in writing elsewhere in the 
EULA. Keysight shall be under no obligation 
to update, revise or otherwise modify the 
Software. With respect to any technical 
data as defined by FAR 2.101, pursuant to 
FAR 12.211 and 27.404.2 and DFARS 
227.7102, the U.S. government acquires no 
greater than Limited Rights as defined in 
FAR 27.401 or DFAR 227.7103-5 (c), as 
applicable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED "AS IS," AND IS 
SUBJECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. KEYSIGHT SHALL 

NOT BE LIABLE FOR ERRORS OR FOR 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES IN CONNECTION WITH THE 
FURNISHING, USE, OR PERFORMANCE OF 
THIS DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD KEYSIGHT 
AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WARRANTY 
TERMS COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH THESE 
TERMS, THE WARRANTY TERMS IN THE 
SEPARATE AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. 
Do not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided with your instrument on CD-ROM and/or in printed form. Printed manuals 
are an option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type in your product number in the Search field at the top of the 
page. Safe operation and the general safety precautions for the M9502A and M9505A 
AXIe chassis, must be followed. See: http://www.keysight.com/find/M9505A.

Initial Inspection Inspect the shipping container for damage. If there is damage to the container or 
cushioning, keep them until you have checked the contents of the shipment for 
completeness and verified the instrument both mechanically and electrically. The 
Performance Tests give procedures for checking the operation of the instrument. If the 
contents are incomplete, mechanical damage or defect is apparent, or if an instrument 
does not pass the operator’s checks, notify the nearest Keysight Technologies 
Sales/Service Office.

WARNING To avoid hazardous electrical shock, do not perform electrical tests when 
there are signs of shipping damage to any portion of the outer enclosure (covers, panels, 
etc.).

General The protective features of this product may be impaired if it is used in a manner not 
specified in the operation instructions.

WARNING
To ensure mandatory safety requirements are being met, the module 
must be installed in a chassis which has been certified and marked by a 
Nationally Recognized Testing Lab (such as CSA, UL, TUV, ETL etc.) in 
which all the means of protection are properly implemented. 
NOTE: CE marking alone is not adequate.

NOTE
This product has been designed and tested in accordance with accepted 
industry standards, and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed 
by the user to ensure safe operation and to maintain the product in a safe 
condition.

http://www.keysight.com
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Laser Safety Information Class 1 Laser product according IEC60825-1 (2007). 

ESD Sensitive Device All front-panel connectors of the M8121A are sensitive to Electrostatic discharge (ESD). 
There are also several exposed components on the PCAs, on both sides of M8121A, which 
can be touched accidentally while handling the unit and can risk damage to the 
instrument, due to ESD. It is recommended to operate the instrument in an electrostatic 
safe environment. There is a risk of instrument malfunction when touching a connector or 
side components. Please follow this instruction described in the “ESD Protection” section 
under “M8121A Maintenance”. 

Environment Conditions This instrument is intended for indoor use in an installation category II, pollution degree 2 
environment. It is designed to operate within a temperature range of 0 °C – 40 °C 
(32 °F – 105 °F) at a maximum relative humidity (non-condensing) of 95% up to 40 °C 
and at altitudes of up to 2000 meters.

This module can be stored or shipped at temperatures between -40 °C and +70 °C. 
Protect the module from temperature extremes that may cause condensation within it.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Line Power Requirements The Keysight M8121A operates when installed in a Keysight AXIe mainframe.

Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the ac power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.
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Instrument Markings
The table below lists the definitions of markings that may be on or with the product.

Table 1  Instrument Markings

Symbol Description

The instruction documentation symbol. The product is marked with this symbol 
when it is necessary for the user to refer to the instruction in the documentation.

Frame or chassis ground terminal. Typically connects to the equipment’s metal 
frame.

South Korean Certification (KC) mark; includes the marking’s identifier code which 
follows this format:
R-R-Kst-ZZZZZZZZZZZZZZ 

Indicates that anti-static precautions should be taken.

China Restricted Substance Product Label. The EPUP (environmental protection use 
period) number in the center indicates the time period during which no hazardous 
or toxic substances or elements are expected to leak or deteriorate during normal 
use and generally reflects the expected useful life of the product. 

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

Hazardous laser radiation.

Caution, hot surface. 
In case the system is running for a longer time, the surface (cover and bottom) of the
module can heat up to 60 degree. Therefore, the user should carefully remove the 
module from the AXIe chassis.
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The CSA mark is a registered trademark of the CSA International.

The CE mark is a registered trademark of the European Community (if accompanied 
by a year, it is the year when the design was proven). This product complies with all 
relevant directives. 

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

IP x y The instrument has been designed to meet the requirements of “IP x y”, where “x” is 
the solid particle protection and “y” is the liquid ingress protection. 

ISM 1-A This is a symbol of an Industrial Scientific and Medical Group 1 Class A product. 
(CISPR 11, Clause 5)

ICES / NMB-001 This is a marking to indicate product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001)

The Keysight email address is required by EU directives applicable to our product.

This symbol indicates separate collection for electrical and electronic equipment, 
mandated under EU law as of August 13, 2005. All electric and electronic 
equipment are required to be separated from normal waste for disposal (Reference 
WEEE Directive, 2002/96/EC).
Do not dispose in domestic household waste.
To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.

Symbol Description
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This chapter provides an overview of M8121A Arbitrary Waveform 
Generator.
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1 Introduction
 

M8121A Overview

The Keysight M8121A is a 12 GSa/s AWG (Arbitrary Waveform Generator) 
with full bandwidth streaming capability. It combines excellent signal 
fidelity with high sampling rates, and with its ability to stream data over a 
full bandwidth interface, can generate signals of indefinite length. 

Conventional AWGs have a certain amount of built-in waveform memory 
that allows the user to generate pre-calculated waveform segment(s) 
under the control of a sequencer. But no matter how large the memory of 
an instrument is, it is a finite resource and eventually a loop will occur. 
Even the most complex sequencing engine does not eliminate this basic 
limitation.

The M8121A uses a different approach: Instead of a built-in memory, it 
offers a full rate Optical Data Interface (ODI) to supply the samples to the 
DAC at up to 12 GSa/s, which enables infinitely long scenarios to be 
generated with up to approx. 5 GHz of modulation bandwidth.

Key Features

The M8121A is a 12 GSa/s Arbitrary Waveform Generator with the 
following key features:

• 1 or 2 channel AWG module with

• 14-bit resolution up to 8 GSa/s

• 12-bit resolution up to 12 GSa/s

• Variable sample rate from 1 GSa/s to 12 GSa/s

• Internal broadband clock synthesizer

• Optional low-phase-noise clock input

• Optional real-time digital signal processing in Keysight Technologies, 
Inc. proprietary ASIC for Digital up-conversion to IF

• Form-factor: 2 slot AXIe module, controlled via external PC or AXIe 
system controller 

Optical Data Interface (ODI)

• 160 Gb/s optical streaming interfaces

• Supports full rate, gapless streaming of samples into the M8121A from 
compatible storage, DSP or digitizer devices or custom hardware
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Two Output Paths for Different Applications

• Direct DAC — optimized for best SFDR & HD 

• Amplitude 350 mVpp ... 700 mVpp, offset –20 mV ... +20 mV 

• Differential output

• Optional DC coupled amplifier 

• Amplitude 500 mVpp ... 1.0 Vpp

• Output voltage window: –1.0 V … +3.3 V 

• Differential output

Feature Options

The following feature options are available for the current release of 
M8121A:

Table 2  M8121A feature options

Option Functionality

001 1 channel 

002 2 channel 

08G 8 GSa/s, 12 or 14 bit 

12G 12 GSa/s, 12 or 14 bit to < 8 GSa/s, 12 bit >= 8 GSa/s

AMP DC amplifier

DUC Digital Up-Conversion

LPN Low Phase Noise
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DAC Format Modes 

Each channel internally uses two DACs (A & B). Each DAC usually 
contributes to the signal 50% of a sample period. 

The following three DAC format modes are available: 

• NRZ (Non Return to Zero) 

• DNRZ, (Double NRZ) 

• Doublet 

For more details on the DAC format modes, refer to the section “Dual-Core 
DAC Architectures” in the Fundamentals of Arbitrary Waveform Generation 
Reference Guide (Manual Part No. M8190-91050).

Figure 1 DAC Format Modes

NRZ: DAC A sends value for 
whole sample period

DNRZ: DAC A and B send same value Doublet: DAC A sends +Value, 
DAC-B sends –Value
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The three modes have different amplitude vs. frequency responses, which 
are shown in the following figure:

Figure 2 DNRZ/NRZ/Doublet Frequency Response

NOTE
This is only comparing the idealized response of the modes, and ignores 
the roll off due to finite switching rise times, output RC time constant and 
other losses.
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DNRZ Best signal performance in 1st Nyquist region

NRZ For time domain applications, less ripple at 2 fsample, more distortions than 
DNRZ

Doublet More output power and flatter frequency response in 2nd Nyquist region

  =  ( )
 

  =  ( )
 

  =  (2)(2)2
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Front Panel

Figure 3 on page 17 illustrates the front panel of the M8121A instrument.

Figure 3 M8121A front panel

The M8121A front panel includes the following input/output ports: 

Inputs/Outputs

• Flow Ctrl - This port is reserved for future use.

• Sample Mrk Out - The two Sample Marker Out ports (Sample Mrk 
Out 1/2) can be used to mark the beginning of a certain position in the 
analog signal. It has timing resolution of one sample clock cycle. The 
Marker signal can be used to trigger external equipment.

• Direct Out - The two Direct Out ports (Direct Out 1/2) are the 
differential outputs of the two digital to analog converters. The outputs 
can be switched ON or OFF.

• Amp Out - The two Amplifier Out ports (Amp Out 1/2) are the amplified 
output signals of the DAC. Amp Out is available if option -AMP is 
installed. Option -AMP is SW upgradeable.

• LPN Clk Out - The LPN (Low Phase Noise) Clock Output can be used to 
output the clock signal from the LPN clock input.  For convenience, a 
semi-rigid cable that connects between LPN Clk Out and Sample Clk In 
is provided to allow users to programmatically switch between LPN 
clock and Sample Clk In without re-cabling. The LPN ports are only 
available if option -LPN is installed. Option -LPN is SW upgradeable.

• ODI - The two Optical Data Interface ports (ODI 1/2) can be used to 
connect to other ODI ports that provide streaming waveform data. 

• Sys Clk Out - This port is reserved for the future use.

• Sys Clk In - This port is reserved for the future use.

• Sample Clk In - The Sample Clock Input can be used if an external 
clock source shall be used to clock the analog to digital to converters. 
Clock to data delay control is available when using Sample Clk In.

Arbitrary Waveform Generator

Sample Clk
Out

Sample Clk
In

Ref Clk
Out

Ref Clk 
In

LPN Clk
In

Sync
In

Vector Mrk
Out 1

Vector Mrk
Out 2

Vector Clk
Out

Trigger
In

Aux
In

AccessFail

M8121A 12 GSa/s 
LPN Clk Out

Sys Clk
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Sys Clk
In

+8 dBm MAX 3 Vpp MAX -1.5 V... 4 V MAX-1.5 V... 4 V MAX ±10 V MAX +10 dBm MAX
±4 V MAX

±10 V MAX

ODI 2ODI 1

Sample Mrk
Out 1

Flow Ctrl 1 Direct Out 1 Direct Out 1 Amp Out 1 Amp Out 1 Sample Mrk
Out 2

Flow Ctrl 2 Direct Out 2 Direct Out 2 Amp Out 2 Amp Out 2
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• Sample Clk Out - The Sample Clock Output provides the clock selected 
for use in the M8121A.

• Ref Clk In - The Reference Clock Input can be used to synchronize to an 
external clock.

• Ref Clk Out - The Reference Clock Output can be used to synchronize a 
DUT to the M8121A.

• Vector Mrk Out - This port has a similar functionality as the sample 
Marker Output. It has timing resolution of 64 sample clock periods for 
direct 14- and 12-bit modes, and 32 I/Q sample pairs for DUC modes.

• Vector Clk Out - The Vector Clock Output can be used to synchronize 
with external customer DUT. 

• Trigger In - This port is reserved for future use.

• Aux In - This port is reserved for future use.

• Sync In - This port is reserved for future use.

• LPN Clk In - This port is used when the “Low Phase Noise External” 
is selected as the Sample Clock source. Low phase noise (LPN) is used 
with an externally connected high quality clock. Clock to data delay 
control is not available when using LPN Clk In. LPN is available if 
Option -LPN is installed. Option -LPN is software upgradeable.

• FPGA Config - This port is reserved for future use.

LEDs

The M8121A front panel includes the following LEDs:

• Status LEDs

The “Fail” and “Access” LEDs are available at the front panel to indicate 
the status of the M8121A module:

• The green ‘Access’ LED indicates that the controlling PC exchanges 
data with the M8121A module. This LED blinks after power on, and 
remains solid after the module’s PCIe endpoint has enumerated on 
the bus and is ready for communication.

• The red ‘Fail’ LED is ‘ON’ for about 2 seconds after powering the 
AXIe chassis. After about 2 seconds the red LED is switched ‘OFF’. 
During normal operation of the module this LED is ‘OFF’. In case of 
an error condition such as e.g. a self-test error, the LED is switch 
‘ON’.
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Related Documents

To access documentation related to the Keysight M8121A AWG, use one 
of the following methods:

• CD - Browse the product CD for M8121A documentation.

• Start > All Programs > Keysight M8121 > Keysight M8121
Documentation - Provides links to all product documentation.

• Start > All Programs > Keysight M8121 > Keysight M8121 Examples -
Provides example waveform files.

• Go to the product web site (www.keysight.com/find/M8121A) and
browse the manuals under Document Library tab.

Additional Documents

Additional documentation can be found at:

• http://www.keysight.com/find/M9502A for 2-slot chassis related
documentation.

• http://www.keysight.com/find/M9505A for 5-slot chassis related
documentation.

• http://www.keysight.com/find/M9514A for 14-slot chassis related
documentation.

• http://www.keysight.com/find/M9537A for embedded AXIe controller
related documentation
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This chapter explains the steps required to install M8121A software 
package.
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Pre-Requisites 

The following are the pre-requisites for installing Keysight M8121A 
software:

The supported operating systems are:

• Windows 10 (64 bit)

• Windows 8.1 (64 bit)

• Windows 7 (64 bit)

Ensure that you have Keysight IO Libraries Suite version 18.0 or higher 
installed on your system. The Keysight IO Libraries Suite can be found on 
the CD that is part of shipment content or at 
http://www.keysight.com/find/iosuite

NOTE
Even if a non-Keysight I/O library is already installed on your PC, it is still 
necessary to install the Keysight I/O library. The Keysight I/O library will 
install as “secondary” I/O library in this case.
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Installation Process

Follow the given steps to install Keysight M8121A software on your 
system:

1 Double-click the executable (M8121A_Setup.exe). This executable file 
is available either on CD or Web.

2 The Keysight M8121A Setup will prepare the InstallShield Wizard for 
the installation process. The following window will appear.

NOTE
The installer will first check and list some pre-requisites. Click Install to 
install them. It is possible that your PC requests a reboot during this 
step. Reboot your PC, if requested.
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3 Follow the on-screen instructions to begin the installation process.

Click Next. 

4 We recommend you to read the document to check if your hardware 
configuration is supported. Click Next to proceed to the license 
agreements.
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5 Accept the terms of Keysight software end-user license agreement and 
click Next.

6 Select Yes if you want to read the post-installation instructions when 
finished. Click Next to select setup type.
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7 Select a setup type either Complete or Custom. Click Next.

8 If you select Custom and click Next, you can specify which optional 
features will be installed:
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9 Click Next to begin installation.
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10 The Setup Wizard will now install M8121A.
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11 The Keysight M8121A will configure the new software installation.

The following screen will appear once the Keysight M8121A software is 
successfully installed on your system.

Click Finish to restart your system. Do not connect the AXIe chassis to 
your system using the PCIe cable during this reboot.
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12 This completes the Keysight M8121A software installation.
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Post Installation Steps

Follow the post installation steps as shown below: 

1 Shut down PC and instrument.

2 Connect the instrument to the PC using the PCIe cable.

3 Switch on the instrument. Wait until the ‘Access’ LED is solid green (no 
longer flashing). Red indicates an error condition.

4 Switch on the PC.

5 The PC should automatically recognize the instrument.

Check this in the device manager; e.g. via Start > Control Panel > Device 
Manager, or right-click Computer > Manage > Device Manager.

The instrument should be visible in the device tree as Keysight 
Technologies Modular Devices > M8121A 

6 Check if the M8121A is also visible in the Keysight Connection Expert 
application. 

7 If something went wrong and the instrument is not showing in the 
Instruments tab in Keysight Connection Expert, it may be necessary to 
reboot the PC once more.

NOTE
Post installation steps must be followed strictly in the same order as 
mentioned for successful connection of the PC with M8121A. 

NOTE
Your PC might request a reboot. Reboot your PC, if requested.
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How to use the M8121A Instrument

In order to use the instrument:

1 When using the PCIe link to control the M8121A, the AXIe chassis 
must be switched on before you start the PC. The green status LED on 
the M8121A front panel must change from blinking to solid before 
switching on the external PC.

2 Start the M8121A application (Start > All Programs > Keysight M8121 
> Keysight M8121). The user interface will display the VISA resource 
strings for different kinds of connections (there may be more than one, 
depending on what the PC is connected to, and what other AXIe 
modules are in the chassis). Select the M8121A. For more details, see 
the section Launching the M8121A Soft Front Panel on page 40.

NOTE
You must start the M8121A application in order to send SCPI commands 
to the instrument. The connection string can be found in the “About” Box.
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M8121A Maintenance

This system should be serviced only by authorized personnel.

ESD Protection

Electrostatic discharge (ESD) can damage or destroy electronic 
components. All work on electronic assemblies should be performed at a 
static-safe work station. The following list and figure shows an example of 
a static-safe work station using two types of ESD protection. Purchase 
acceptable ESD accessories from your local supplier.

• Conductive table-mat and wrist-strap combination.

• Conductive floor-mat and heel-strap combination.

WARNING
Using controls or adjustments or performing procedures other than 
those specified in the documentation supplied with your equipment can 
result in hazardous radiation exposure.

CAUTION
All the connectors are very sensitive to electrostatic discharge (ESD). 
There are also several exposed components on the PCAs, on both sides 
of the M8121A, which can be touched accidentally while handling the 
unit and can risk damage to the instrument, due to ESD. When you 
connect a device or cable that is not fully discharged to these 
connectors, you risk damage to the instrument and expensive instrument 
repairs.

CAUTION
Electrostatic discharge (ESD) can damage the circuits of the M8121A. 
Avoid applying static discharges to the front-panel connectors. Avoid 
touching the front-panel connectors without first touching the frame of 
the instrument. Be sure the instrument and all connected devices (DUT, 
etc.) are properly earth-grounded (to a common ground) to prevent 
buildup of static charge and electrical over-stress.
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Figure 4 ESD protection

Both types, when used together, provide a significant level of ESD 
protection. Of the two, only the table-mat and wrist-strap combination 
provides adequate ESD protection when used alone. To ensure user safety, 
the static-safe accessories must provide at least 1 MW of isolation from 
ground.

WARNING
These techniques for a static-safe work station should not be used when 
working on circuitry with a voltage potential greater than 500 volts.
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Power and Ventilation Requirements

For power and ventilation requirements, refer to:

• http://www.keysight.com/find/M9514A for 14-slot chassis related 
documentation.

• http://www.keysight.com/find/M9505A for 5-slot chassis related 
documentation.

• http://www.keysight.com/find/M9502A for 2-slot chassis related 
documentation.

Thermal Protection

Overheating Detection

The instrument monitors its internal temperature. If the temperature 
exceeds what the instrument can tolerate, the power supply is switched 
off. The instrument will not turn on automatically if the temperature is 
decreasing again. 

Fan Failure

If a fan is broken or prevented from operating by a blockage the 
temperature will increase. When the temperature exceeds what the 
instrument can tolerate, the overheating detection switches off the 
instrument for safety reasons. For reliability it is recommended to send 
instruments with broken or defective fans immediately to Keysight Service 
for repair.

Battery

The M8121A module does not have a battery.

Operating Environment

For details on the operating environment for the M8121A module, refer to 
the section Operating Environment on page 139.
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Fiber Optic Connector Care for Optical Data Interface (ODI)

The fiber optic connector care is vital to maintain good measurements and 
avoid costly repairs caused by damage to fiber optic connectors on optical 
test equipment.

Improper connector care, cleaning, or use of mismatched cable 
connectors can invalidate the published specifications and damage 
connectors. Clean all cables before applying to any connector. Repair of 
damaged connectors due to improper use is not covered under warranty.

Treat all fiber-optic connectors like the high-quality lens of an expensive 
camera. Damage to the connectors on calibration and verification devices, 
test ports, cables, and other devices can:

• Degrade measurement accuracy and repeatability and

• Cause expensive damage to instruments.

Because fiber-optic connectors are susceptible to damage that is not 
immediately obvious to the naked eye, it is very easy to make bad 
measurements without being aware of a connector problem. Learning 
about proper handling and cleaning techniques will help you to avoid any 
degradation in connector performance. With glass-to-glass interfaces, any 
damage of the ferrule or end of the fiber, any stray particles, or finger oil 
can have a significant effect on fiber-optic connectors.

This picture shows the end of a clean, problem-free fiber-optic connector.
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Guidelines

• Use a fiber-optic inspection scope to visually inspect the fiber-optic 
end.

• Always remove both ends of fiber-optic cables from any instrument, 
system, or device before visually inspecting the fiber ends. Disable all 
optical sources before disconnecting fiber-optic cables. Failure to do 
so may result in permanent injury to your eyes.

• Keep all fiber-optic connectors clean using professional fiber-optic 
cleaning products. Many products are available and are easily located 
via an Internet search on "fiber optic cleaning products". You can 
purchase tools designed specifically for the type of fiber-optic 
connector that you are using. For the 24-fiber MPO interface, purchase 
one for MPO II – MTP® Brand Connectors.

• Never use metal or sharp objects to clean a connector and never 
scrape the connector.

This picture shows physical damage to the glass fiber end of the optical 
cable caused by either repeated connections made without removing 
loose particles from the fiber end or by using improper cleaning 
processes. 

This damage can be severe enough to transfer the damage from the 
connector end to a good connector with which it comes in contact.

The cure for these problems is disciplined connector care.  Visual 
inspection of fiber ends can be helpful. Contamination or imperfections 
on the cable end face can be detected as well as cracks or chips in the 
fiber itself. Use a microscope to inspect the entire end face for 
contamination, scratches on the fiber core, raised metal or dents, and any 
other imperfections. 

Visible imperfections not touching the fiber core may not affect 
performance unless the imperfections keep the fibers from contacting.
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• When inserting a fiber-optic cable into a connector:

• Gently insert it in as straight a line as possible. Tipping and inserting 
at an angle can scrape material off the inside of the connector or 
even break the inside sleeve of connectors made with ceramic 
material.

• Ensure that the fiber end does not touch the outside of the mating 
connector or adapter.

Cleaning

Keep all fiber-optic connectors clean using professional fiber-optic 
cleaning products. Many products are available and are easily located via 
an Internet search on "fiber optic cleaning products". You can purchase 
tools designed specifically for the type of fiber-optic connector that you 
are using. For the 24-fiber MPO interface, purchase one for an MTP 
connector.

Fiber Optic inspection scopes are available which can give a very clean 
view of the fiber end and even provide some analysis capability.

WARNING
If flammable fluids are used to clean connectors, the fluid shall not be 
placed on the instrument during use or when connected to mains 
voltage. Cleaning the connectors shall take place in ventilated area to 
allow fluid vapors to dissipate and reduce the risk of fire.

WARNING
Always remove both ends of fiber-optic cables from any instrument, 
system, or device before visually inspecting the fiber ends. Disable all 
optical sources before disconnecting fiber-optic cables. Failure to do so 
may result in permanent injury to your eyes.
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Launching the M8121A Soft Front Panel

Select Start > All Programs > Keysight M8121 > Keysight M8121 from 
the Start menu.

The following Connect to Instrument dialog will appear:

Figure 5 M8121A connected to PC

This dialog shows the addresses of the discovered M8121A modules. 
Select a module from the list and click “Connect”.

If no M8121A module is connected to your PC, you can select “Simulation 
Mode” to simulate an M8121A module.
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Figure 6 M8121A connected in simulation mode

Next, a M8121A software startup screen will be displayed as shown in 
Figure 7 on page 42. 

New image required.
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Figure 7 M8121A startup screen
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M8121A Soft Front Panel

The M8121A Soft Front Panel and its GUI elements are illustrated in 
Figure 8 on page 43.

Figure 8 M8121A user interface

The M8121A Soft Front Panel includes the following GUI elements:

1 Title Bar

2 Menu Bar

3 Tabs

4 Status Indicator

5 Messages

6 Lower Pane
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Title Bar

The title bar contains the standard Microsoft Window elements such as the 
window title and the icons for minimizing, maximizing, or closing the 
window.

Menu Bar

The menu bar consists of various pull down menus that provide access to 
the different functions and launch interactive GUI tools.

The menu bar includes the following pull down menu:

• File

• View

• Utilities

• Tools

• Help

Each menu and its options are described in the following sections.

File Menu

The File menu includes the following selections:

View Menu

The View menu includes the following selections:

File > Save Configuration… Saves configuration as a text file. 

File > Save Configuration As… Saves configuration as a text file. Not functional in the current software 
release. 

File > Load Configuration… To be implemented. Loads the previously saved configuration file. Not 
functional in the current software release.

File > Exit Exits the M8121A application.
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Utilities Menu

The Utility menu includes the following selections:

Tools Menu

The Tools menu includes the following selections:

Help Menu

The Help menu includes the following selections:

View > Preferences... Opens the Display Setting dialog which allows you to set the display 
settings. For more details, refer to Display Settings Dialog on 
page 46.

Utility > Reset Resets the instrument, reads the state and updates all fields.

Tools > SCPI Editor... Opens SCPI Editor that lists all SCPIs that can be used to program M8121A 
and also provides a platform to execute them. For details, see SCPI 
Editor on page 47.

Help > Contents Opens the M8121A User Guide.

Help > Online Support Opens the instrument’s product support web page.

Help > About Displays product information including version number, build date, build 
info, installed licenses, available options and web links for M8121A 
information and support.
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Display Settings Dialog

The Display Settings dialog allows you to set the display the GUI.

Figure 9 Display Settings dialog

Using this dialog, you can apply the provided setting to the interface skin, 
color, font, font skin, message icons, and number format.
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SCPI Editor

The SCPI Editor lists all SCPI that can be used to program M8121A and 
also provides a platform to execute them. 

The following figure depicts the elements of the SCPI Editor:

Figure 10 SCPI Editor

It has the following elements:

• Command list - Shows the list of default commands.

• Output Area - Allows you to enter a command. Also the output of the 
executed command is displayed in this area.

• Send Button - Press this button once you select the command from the 
command list or enter a SCPI.

• Show Error Queue - Select this check-box to show the errors which are 
generated when a command is executed. 

• Clear - Clears the Output area. 
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Status Indicator

The Status Indicator window displays the status of the analog outputs of 
each channel of the M8121A module. 

This include:

• Data indicates the data source: either “Streaming” data over the ODI 
port, or from internal “Waveform” memory.

• Mode reports the selected data format.

• Clock reports status of the sample clock; green means ready and red 
means there is no detection of correct clock signal of the selected 
sample clock.

• The ODI Sync LED is lit when the ODI port is activated and 
synchronized with the data source.

• The ODI FIFO LED is lit when there are brief gaps in the ODI data stream 
during otherwise continuous operations. It also indicates when ODI 
data starts / flows / stops (for example, when the Rapids play a 
recording).

• Gray when inactive (output off, or Data source internal).

• Yellow when ODI is waiting for sync.

• Gray when ODI is synced and there is no ODI data (ODI data rate == 
0 during previous 1s).

• Green when ODI is synced and ODI data is flowing (rate > 0 over 1s 
period) without FIFO underflowing.

• Red when ODI is synced and FIFO underflow detected. Remains red 
until ODI stops being transmitted (rate == 0 for at least 1 sec).

• Direct Out and Amp Out ports for each channel (indicated by green 
LED).

• The Triggered LED is lit when the trigger event is initiated or when the 
continuous mode of trigger is selected. 

• Continuous mode – Always green when the continuous trigger 
mode is selected.

• Triggered mode – Green when trigger action is performed and 
grayed out when the trigger is stopped.

• Start button to start the waveform.

• Stop button to stop the waveform.

• Press the ARM button to set to an armed state. Signal generation is 
started after a trigger is received. This option is applicable only when 
Triggered option is selected under the Trigger Mode drop-down list.
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Figure 11 Status Indicators

Messages

The Messages window displays the messages, warnings, and errors. You 
can also filter the messages, warnings and errors so that they get 
displayed on the Messages window. For each messages, warnings, and 
errors, it also shows the details i.e. notification type, message log, details 
and time.

Figure 12 Messages window

It has the following controls, signs, and columns:

Messages Click this button to show/hide messages.

Warnings Click this button to show/hide warning messages.

Errors Click this button to show/hide the error messages.
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Status Bar

The status bar contains the following fields from left to right:

• Connection state “Not Connected” – No instrument is connected. 
“Connected: <Instrument resource string>” – An instrument is 
connected. The resource string, for example PXI36::0::0::INSTR is 
displayed. “Simulation Mode” – No real instrument is connected. The 
user interface is in simulation mode. Click this field to open the 
Instrument Selection Dialog.

• Instrument status - Displays the instrument status, for example “Reset 
complete” after issuing a reset command. 

• Show messages/warning/errors - Click the “Error Count”  button 
to view the window to view messages, warnings, and errors on the 
Message window. 

Save... Click this button to save the selected messages, warnings 
or errors, inside the list, to a specified location.

Copy Click this button to copy the selected messages, warnings 
or errors. Once you perform the copy operation, you can 
later paste them in any text editor. 

Clear Click this button to clear all the messages, warnings or 
errors from the Messages window.



Keysight M8121A Arbitrary Waveform Generator User Guide 51

Soft Front Panel 3

 

Working with M8121A Front Panel

Numeric Control Usage

The numeric control is used to adjust the value and units. Whenever you 
bring the mouse pointer over the numeric control, a tool tip appears which 
shows the possible values in that range.

Figure 13 Tool tip showing possible values in the range

The numeric controls can be used in the following ways:

Use the up/down arrows to change the value. The control automatically 
stops at the maximum/minimum allowed value.

You can increase or decrease the value starting at a specific portion of the 
value. To do this, place the cursor to the right of the targeted digit and use 
the up/down arrows. This is especially useful when changing a signal 
characteristic that is immediately implemented and observing the result in 
another instrument. For example, you can change the signal generator’s 
frequency by increments of 10 MHz and observe the measured result in a 
signal analyzer:

Figure 14 Typing directly into the field

Type directly into the field and press the Enter key. If you enter a value 
outside the allowed range, the control automatically limits the entered 
value to the maximum or minimum allowed value.

When you type the value, you can type the first letter of the allowed unit of 
measure to set the units. For example, in the Frequency control you can 
use "H", "K", "M", or "G" to specify Hz, kHz, MHz or GHz, respectively. 
(The control is not case sensitive.)
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The controls allow scientific notation if it is appropriate to the allowed 
range. Type the first decimal number, enter an "E", and omit any trailing 
zeroes. For example, in the Frequency control you can type 2.5e+9 and 
press [Enter] to set the frequency to 2.5 GHz. (The plus sign is 
automatically inserted if it is omitted.)

Tooltip

The tooltip is a small pop-up window that concisely describes the object 
being pointed to, such as descriptions of toolbar controls, icons, graphics, 
links, menu items and taskbar buttons.

The following example shows the tooltip providing a description of toolbar 
buttons. 

Figure 15 Tooltip example 1

Here is another example where the tooltip provides information to the user 
on the minimum and maximum values the parameter can hold.

Figure 16 Tooltip example 2
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Clock and Output Tab

The Clock and Output tab is used to configure the clock and outputs of the 
M8121A module. It includes input fields for the clocks 
(Internal/External/LPN) to configure the relevant frequencies and also 
includes the outputs of the channel of M8121A Module.

Figure 17 Clock and Outputs tab

This tab has the following options:

Clock

• Sample Clock - Use this drop-down list to select the sample clock 
among Internal, External or Low Phase Noise (LPN) External.

• The clock power to the LPN input should be removed when using 
the Internal clock.

• Use the semi-rigid cable to connect the LPN Clock Out to the 
Sample Clock In when switching between the External and LPN 
clock sources. This eliminates the need to re-cable.
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• Internal Frequency - Use this option to set the frequency of the 
internally generated sample clock.

• External Frequency - Use this option to specify the frequency of the 
selected external clock source.

• Vector Clock - This is read-only and reports the vector clock frequency 
that is available from the Vector Clk Out port.

• Reference Clock - Use this drop-down list to select the reference clock 
source from:

• Internal - Reference generated by an internal oscillator inside 
M8121A module.

• External - Reference from Ref Clock In. 

• AXI - Reference from AXI Backplane of the AXIe chassis.

• Default - For Default option, the AXI value is applicable.

• External Frequency - Use this option to set the frequency of the used 
external reference clock.

• Multi-Module Role - This is a read-only field. Depending upon the 
M8192A module connection, it displays one of the following:

• Normal - When the M8121A module is not configured in the 
M8192A module.

• Master - When the M8121A module is configured as Master in the 
M8192A module. 

• Slave - When the M8121A module is configured as Slave in the 
M8192A module.

Channel 1/ Channel 2

• Outputs - Click on the button to enable/disable the output port 
(normal and complement for Direct DAC Out) for channels 1 and 2.

• Mode - Selects the waveform output modes. Available selections are:

• 12 bit Direct

• 14 bit Direct

• Interpolated mode: x3/x12/x24/x48

• Channels Coupled - Use this check box to select the coupling mode of 
the two channels. The channels can operate in coupled or uncoupled 
mode.

• Format - Selects among the DAC format modes.

• DNRZ: DAC A and B send same value.

• NRZ: DAC A sends value for whole sample period.

• Doublet: DAC A sends +Value, DAC B sends –Value
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• Output - Select the output path.

• DAC Direct Out

• DC Amp Out

• Reduced Noise Floor- Select this option to enable the “Reduced Noise 
Floor” feature. When the reduced noise floor feature is enabled, there is 
less phase noise in the generated output signal.

The M8121A has a delay adjustment in the module that allows a delay 
to be added to a channel’s output signal. Using the delay adjustment, a 
user can delay the signal on one channel compared to the signal on the 
other channel. One reason for this might be to compensate for 
differences in delay caused by different cable lengths. It is also possible 
to use the delay adjustment to set an arbitrary delay offset between the 
channels. 

The delay line used for the delay adjustment adds phase noise to the 
output signal. When the reduced noise floor feature is enabled, this 
delay line is by-passed so that phase noise is reduced. When reduced 
noise floor is enabled, the delay adjustment is not available. 

• Amplitude - Sets the amplitude of the output signal.

• CM Offset - Sets the CM (common mode) offset of the output signal

• Diff. Offset - Sets an offset adjustment to compensate for small offset 
differences between the normal and complement output. 

• Coarse Delay - Specifies the coarse delay portion of the variable delay.

• Fine Delay - Provides a small range of delay that may be added to the 
output signal on either channel.The fine delay is not available when 
using the Low Phase Noise clock source or when the Reduced Noise 
Floor box is checked. The range is dependent on the sample frequency 
as follows:

• Sample freq >= 6.25 GSa/s:  0-30 ps

• 2.5 GSa/s <= Sample freq < 6.25 GSa/s:  0-60 ps

• Sample freq < 2.5 GSa/s:  0-150 ps

• Carrier Scale - Sets the carrier amplitude scale for interpolated modes. 
The Carrier Scale refers to the amplitude of the carrier signal in 
Up-Conversion Mode (Interpolated Mode). IQ data is used to modulate 
the carrier signal. An interpolation filter is applied which may result 
(depending on the IQ data values) in final DAC values that are outside 
the valid range of the DAC. In that case the signal is clipped, and a 
warning message is displayed in the Error List Window. When clipping 
is not acceptable, the user can set a smaller carrier scale. The default 
value for carrier scale guarantees in all cases a signal without clipping.

• Carrier Frequency - Set the carrier frequency for interpolated modes.
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Trigger tab

The Trigger tab is used to configure the trigger inputs of the M8121A 
module.

This tab has the following options:

• Trigger Mode - Use this drop-down list to select the trigger mode 
value. 

The following options are available:

• Continuous – Signal generation starts immediately after pressing 
the Run button. No trigger needed.

• Triggered – Signal generation starts after a trigger is received.

• Force Trigger - Use this button to force a trigger when waiting for front 
panel trigger. This option is enabled only when Triggered option is 
selected under the Trigger Mode drop-down list.

• Trigger Threshold - Sets the threshold for trigger and event input.

• Polarity - Sets the polarity for the input. 

The following options are available:

• Positive – Rising edge

• Negative – Falling edge

• Either - Both

• Impedance - Sets the impedance of the input.

The following options are available:

• Low (50 Ohm)

• High (1k Ohm)
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Marker tab

The Marker tab is used to configure the marker outputs of the M8121A 
module.

This tab has the following options for Channel 1 and Channel 2.

Vector Marker

• Amplitude - Specifies the amplitude of the marker output signal.

• Offset - Specifies the offset of the marker output signal.

Sample Marker

• Amplitude - Specifies the amplitude of the marker output signal.

• Offset - Specifies the offset of the marker output signal.

For more information on markers, refer to Markers on page 63.
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Data Source Tab

The Data Source tab is used to configure the data source (internal/optical) 
of the M8121A module.

Figure 18 Data Source tab

This tab has the following options:

• Data Source - This drop-down list allows the selection of the data 
source for the waveform. The available options are; Internal (waveform 
memory) and Optical (ODI optical streaming interface). When selecting 
Optical, the following controls are available. 

• Optical Data Source - For the optical data source, the following 
options are available for channel 1 and 2:

• Lane Rate - Currently 14.1 Gb/s is the only supported lane rate.

• Max Burst - This is the maximum burst size and is 2048 (not 
adjustable).
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• Flow Control - Flow control is sometimes needed to control the 
flow of data over the ODI link. Select “In Band” when streaming 
data from a source that is not digitizing data real-time, such as 
a RAID or DSP module. Select “None” when streaming data 
from a digitizer that is digitizing data real-time. If the sample 
clock is shared with the real-time data source, “In Band” or 
“None” can be used.

• Link Channel - Currently, the setting of -1 is supported.

• Packet Format - The M8121A accepts data without any header 
information, so only “None” is available. Other options are 
reserved for future use.

• Class ID - The Class Id should match the format on the Clock 
and Output tab. The incoming data format defined by the Class 
ID should adhere to the ODI standard.

• Packed 12 bit: This can be used when the Mode on the 
Clock and Outputs tab is “12 bit direct”. The data should be 
streamed from the data source in packed 12 bit samples.

• Real 12 bit + marker: This can be used when the Mode on 
the Clock and Outputs tab is “12 bit direct”. The data 
should be streamed from the data source in 16 bit samples 
of which the 12 most significant bits is the sample, and the 
2 least significant bits are the markers.

• Real 14 bit + marker: This should be used when the Mode 
on the Clock and Outputs tab is “14 bit direct”. The data 
should be streamed from the data source in 16 bit samples 
of which the 14 most significant bits is the sample, and the 
2 least significant bits are the markers.

• I/Q 15 bit + marker: This should be used when the Mode on 
the Clock and Outputs tab is any of the Interpolated modes. 
The data should be streamed from the data source in 
interleaved (alternating I and Q) 16 bit samples of which the 
15 most significant bits is the sample, and the 1 least 
significant bit is the marker.

• ODI Activate – This button will reactivate the ODI port. This can 
be used to attempt to resynchronize the M8121A ODI port with 
that of a ODI data producer. ODI statistics are reset whenever 
the ODI port is activated.
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• ODI Test Source - Select the Waveform Memory check box to 
enable the ODI Test Source to play out Waveform Memory over 
ODI, and to view more statistics about the ODI port including 
Bytes Sent and Tx Holdoffs.

Bytes Received, Bad Bursts Received, and Rx Rate (Bytes/s) are 
always displayed.

• ODI Statistics - Display the ODI statistics in terms of Bytes 
Received, Bad Bursts Received, Rx Rate (Bytes/s), Bytes Sent 
and Tx Holdoffs.

• Internal Data Source - For internal data source, the following 
options are available:
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• Input File - Allows you to add the waveform data file. For 
details on the waveform data file, refer :TRACe Commands on 
page 117. Click File... button to provide the waveform data file 
location. The waveform must meet certain length rules that are 
dependent upon the Mode that is selected in the Clock and 
Outputs tab. 

• 12 bit direct: multiple of 192 samples

• 14 bit direct: multiple of 320 samples

• Interpolated mode: multiple of 64 samples

• A 12 bit packed waveform may be loaded and used when 
doing a self-test of the ODI. In this case, the waveform must 
be a multiple of 768 samples.

• The waveform memory size is 1,048,576 bytes, or 524,288 
16-bit samples.
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• Waveform Data - Displays the waveform and allows to set the
markers to the waveform data using the waveform toolbar. The
waveform toolbar provides the following buttons:

• Load into Channel 1/2 - Click these buttons to load the
waveform data to the respective channels (Channel 1and/or
Channel 2).

Uses the mouse to control the marker. The respective position of marker 
at X and Y axis are displayed on the top of waveform.

Takes the marker to the peak position

Turns off the marker

Sets the marker on the I data part of the waveform

Sets the marker on the Q data part of the waveform

Provides zoom functionality. Use the mouse pointer to select the area on 
waveform that you want to zoom. Once done, you can click Auto scale 
icon to zoom out the waveform.

Uses the mouse pointer to move the waveform around. You can also use 
the pan tool when the waveform is zoomed in.

Auto scale the waveform
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This chapter describes the markers supported by M8121A.
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Introduction

The instrument provides output signals with a defined timing relationship 
to the output sample stream. These signals are called markers. 

There are two different types of markers:

• Sample Markers

• Vector Markers

The details of these markers are explained in the sections that follow.

Sample Markers

Sample markers can be used to mark individual samples. 

The following table shows the marker granularity:

Table 3  Marker granularity 

The marker width of one marked sample is fixed to the marker granularity.  
Multiple consecutive marked samples generate one output marker, which 
is expanded to cover all marked bits. The length of this marker is quantized 
to the marker granularity. 

The sample marker is always aligned to the sample data. This alignment 
varies depending on the mode. Delay adjustments also change the delay 
of the sample marker. 

The following drawing shows an example. The dots represent the marked 
samples.

Mode Granularity in DAC Samples

High Speed (Option -12G) 48

High Precision (Option -14B) 40

INT_x3 (Option -DUC) 24

INT_x12 (Option -DUC) 24

INT_x24 (Option -DUC) 24

INT_x48 (Option -DUC) 48
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Figure 19 Samples marked by sample marker

Pause Between Multiple Marked Samples

Due to the quantization of markers, a minimum pause between blocks of 
marked samples is required to see the gap at the sample marker output.

Table 4  Pause between multiple marked samples 

The table above shows the minimum gap size between blocks of multiple 
marked samples/IQ sample pairs. If this condition is violated, it might be 
possible to get one “combined marker” instead two individual markers.

Vector Markers

In addition to the high-speed marker, each channel provides a second 
marker called vector marker. This vector marker can only be set in vector 
clock granularity. 

The vector marker is an output of the pattern generation. Delay 
adjustments do not change the delay of the vector marker. 

Vector Clock

Marked Samples relative 
to Vector Clock Granularity

Sample Marker

Mode Minimum Gap Size

12-bit direct 128 Samples

14-bit direct 128 samples

INT_x3 (Option -DUC) 8 IQ Sample Pairs

INT_x12 (Option -DUC) 2 IQ Sample Pairs

INT_x24 (Option -DUC) 1 IQ Sample Pairs

INT_x48 (Option -DUC) 1 IQ Sample Pairs
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The following drawing shows an example. The dots represent the marked 
clock vectors.

Figure 20 Marked clock vectors

Vector Clock

Marked Samples relative 
to Vector Clock Granularity

Vector Marker
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Introduction

The following diagram shows the hardware structure of features for Digital 
Up-Conversion. 

Figure 21 Hardware Structure of Features for Digital Up-Conversion

The M8121A provides a direct mode, which allows sending sample data 
directly to the output of the instrument. Additionally, it provides 
mechanisms to do IQ modulation internally (highlighted in blue in Figure 
21 on page 68). This includes the interpolation of IQ sample pairs from a 
low input data rate to the sampling rate of the instrument, the generation 
of a carrier frequency by a Numerically Controlled Oscillator (NCO) and the 
IQ modulation itself. 

Direct Mode

In direct mode, the samples are sent directly to the DAC. IQ modulation 
can be implemented by: 

• Using two channels providing I and Q data separately to an external 
analog IQ modulator. This setup is expensive and causes analog 
distortions. 

• IQ modulation can be done by software to generate the samples for an 
IQ modulated signal. 

Keysight Proprietary=



Keysight M8121A Arbitrary Waveform Generator User Guide 69

Digital Up-Conversion 5

 

Digital Up-Conversion Modes

In these modes (see Option -DUC), IQ sample pairs provided by the sample 
data source are interpolated to the selected sample rate and are fed to the 
IQ modulator. The result is sent to the DAC. The benefit is that there are no 
distortions caused by an external analog IQ modulator. 

IQ Modulation

The instrument is able to provide an IQ modulated signal at its output, 
which is based on the IQ data provided by the customer, the selected 
interpolation mode, the carrier frequency and amplitude multiplication 
factor. 

Interpolated Modes

The instrument provides interpolation filters that allow an interpolation by 
x3, x12, x24 and x48. 

The available signal bandwidth of each interpolation filter is 0.8 x Fs where 
Fs is the input I/Q sample rate. Fs multiplied with the interpolation factor 
leads to the DAC sampling rate. 

The following table shows examples for the maximum DAC sample rate of 
7200 MSa/s: 

Table 5  Mode dependent modulation bandwidth 

Markers in Interpolated Modes

Markers can be provided for each incoming IQ sample pair. It is not 
possible to perform marking of interpolated sample values. 

Interpolation Mode Max. Input Sample Rate Max. Modulation Bandwidth

INT_x3 2400 MSa/s 1920 MHz

INT_x12 600 MSa/s 480 MHz

INT_x24 300 MSa/s 240 MHz

INT_x48 150 MSa/s 120 MHz
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For more details about markers, refer to chapter Markers on page 63. 

Amplitude Scaling

The amplitude multiplier allows to scale the amplitude of the DAC output 
signal (see Figure 21 on page 68). 

The chain of interpolation filters and the IQ modulator could increase the 
signal value, which then exceeds the valid DAC range. This leads to a 
clipping of samples. This effect depends on the input data and therefore 
cannot be handled automatically. 

The instrument is able to detect clipping and signals it to the user by the 
status register or a dialog box in the soft front panel. Clipping could be 
prevented by using scale factor values of 1.0 or smaller. This scale factor 
value reduces the output amplitude relative to the direct mode to approx. 
37.6%. 

It is possible to increase the scale factor up to 2.828, but depending on the 
input IQ sample sequence this can result in signal clipping. The value can 
be separated into two multiplication factors: 

• Factor 2.0 is related to the interpolation filters and is dependent from 
the input sample sequence. 

• Factor 1.414 is related to the IQ modulators. The maximum I value (1.0) 
and the maximum Q value (1.0) causes a resulting vector with a length 
of sqrt (2)≈1.414. 

So whenever the user can guarantee that the sum of I and Q doesn’t 
exceed the unit circle, it is safe to set the scale value to 1.414 and increase 
the overall amplitude.

A scale factor of 1.0, which is a “safe” value in terms of clipping, reduces 
the overall possible output amplitude to approx. 37.6 %. Clipping is highly 
depending on IQ input data provided by the user. Therefore, this allows 
scale factor values in the range from 0.0 to 2.828 and allows using as 
much as possible from the available DAC range. The user is responsible to 
select a proper scale value depending on his input data. 

NOTE
The marker to sample output delay is different in the digital 
up-conversion mode compared to the corresponding value in direct 
modes (For details, refer to the M8121A datasheet).
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Doublet Mode and Digital Up-Conversion

The doublet mode is also available for the digital up-conversion modes. 

The frequency band is mirrored at the half of the sample frequency 
(7.2 GHz max). The content of the first Nyquist band (0 – 3.6 GHz max.) 
is transferred to the second Nyquist band (3.6 GHz to 7.2 GHz max.). 
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Remote Programming Overview

Introduction

SCPI programming, optionally using a LAN connection is the way to 
control the M8121A automatically. 

Three LAN protocols are supported: 

• VXI-11: The Visa Resource String is e.g., 
“TCPIP0::localhost::inst0::INSTR”. 

• HiSLIP: This protocol is recommended. It offers the functionality of 
VXI-11 protocol with better performance that is near socket 
performance. Visa Resource Strings look like 
“TCPIP0::localhost::hislip0::INSTR”. The correct resource string is 
shown in the M8121A About Box. 

• Socket: This protocol can be used with any I/O library or using standard 
operating system socket functionality connecting to port 5025. Visa 
Resource string looks like “TCPIP0::localhost::5025::SOCKET”.

Command Line Arguments

Before sending SCPI commands to the instrument, the firmware 
(M8121Firmware.exe) must be started. This can be done in the Windows 
Start menu (All Programs >Keysight M8121 > Keysight M8121). 

(See Communication for details about /s, /t, /i, /AutoID, /NoAutoID, 
/FallBack).

Option Decsription

/Minimized Start minimized.

/Hide Start without application window; only show notify icon.

/s socketPort Set the socket port at which the firmware waits for SCPI commands

/t telnetPort Set the telnet port at which the firmware waits for SCPI commands

/i instrumentNumber Set the instrument number (instN, hislipN) at which the firmware waits 
for SCPI commands

/AutoID Automatically select ports and number for the connections (default 
behavior).
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Communication

Depending on the command line arguments /s, /t, /i, /AutoID, /NoAutoID, 
/FallBack, the firmware starts several servers to handle SCPI commands. 
(Refer the table above.) 

/s, /t, /i: If -1, don’t start the respective servers 

• Defaults: 

• Socket port: 5025 (e.g. TCPIP0::localhost::5025::SOCKET) 

• Telnet port: 5024 

• HiSLIP, VXI-11.3: 0 (e.g. TCPIP0::localhost::hislip0::INSTR, 
TCPIP0::localhost::inst0::INSTR) 

/FallBack: If starting a server fails because of a conflict, try using another 
port or number 

• HiSLIP, VXI-11.3: increase the index until a server can be started 
successfully 

• Socket, Telnet: start with port 60000, then increase it until the servers 
can be started successfully. If neither socket nor telnet is disabled the 
firmware tries to start the servers on two consecutive ports (socket port 
= telnet port + 1) 

/AutoID: Automatically select ports and number for the connections, 
which are unique per instrument. 

• This is the default behavior; it is not necessary to specify this argument 
on the command line. 

• If only one AXIe module is connected to this PC and it is an M8121A 
module, first try to use the command line arguments /s, /t, /i or their 
respective default values if they are not specified. If starting the servers 
fails, proceed with the steps below. 

• /s, /t, /i are ignored (unless they are -1 and a server is disabled) 

• If the firmware detects more than one AXIe module, use a special 
mechanism to obtain a number for the HiSLIP and VXI-11.3 servers, 
which makes sure that the firmware uses always the same VISA 
resource string per module 

/NoAutoID Disable the default behavior; i.e. do not automatically select ports and 
number for the connections.

/FallBack Try to find unused ports and number if starting a server fails.

/r resourceName Visa PXI resource string of the module to connect to, e.g. 
PXI12::0::0::INSTR

Option Decsription
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• The socket and telnet port are then calculated from the HiSLIP index: 

• telnet port = 60000 + 2 * <HiSLIP index> 

• socket port = 60000 + 2 * <HiSLIP index> + 1 

/NoAutoID: Do not automatically select ports and number for the 
connections, use the values specified with /s, /t, /i, /r or their respective 
default values instead. In Win7, /NoAutoID must be used before /s, /t, /i, 
or /r. In Win10, /NoAutoID does not need to be specified before /s, /t, /i, or 
/r.

If both /NoAutoID and /AutoID are specified, /AutoID overrides /NoAutoID.

Instructions

Instructions, both commands and queries, normally appear as strings 
embedded in a statement of your host language, such as Visual Basic for 
Applications (VBA), Visual Basic .NET, C#, C, etc.

The only time a parameter is not meant to be expressed as a string is when 
the instruction's syntax definition specifies <binary_block _data>, such as 
with the :SYSTem:SET command. There are only a few instructions that 
use block data.

Instructions are composed of two main parts:

• The header, which specifies the command or query to be sent.

• The program data, which provides additional information to clarify the 
meaning of the instruction.

Instruction Header

The instruction header is one or more command mnemonics separated by 
colons (:). They represent the operation to be performed by the 
oscilloscope. Queries are formed by adding a question mark (?) to the end 
of the header. Many instructions can be used as either commands or 
queries, depending on whether or not you include the question mark. The 
command and query forms of an instruction usually have different program 
data. Many queries do not use any program data.

NOTE
Ports may already be in use by Windows or other applications, so they 
are not available for M8121A. The first port not assigned by IANA is 
49152 (IANA, Internet Assigned Numbers Authority, 
http://www.iana.org).
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White Space (Separator)

White space is used to separate the instruction header from the program 
data. If the instruction does not require any program data parameters, you 
do not need to include any white space. In this manual, white space is 
defined as one or more spaces. ASCII defines a space to be character 32 in 
decimal.

Braces

When several items are enclosed by braces, { }, only one of these elements 
may be selected. Vertical line ( | ) indicates "or". For example, {ON | OFF} 
indicates that only ON or OFF may be selected, not both.

Ellipsis

... An ellipsis (trailing dots) indicates that the preceding element may be 
repeated one or more times.

Square Brackets

Items enclosed in square brackets, [ ], are optional.

Program Data

Program data is used to clarify the meaning of the command or query. It 
provides necessary information, such as whether a function should be on 
or off, or which waveform is to be displayed. Each instruction's syntax 
definition shows the program data and the values they accept.

When there is more than one data parameter, they are separated by 
commas (,). You can add spaces around the commas to improve 
readability.
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Common Commands

*IDN?

Read the instrument’s identification string which contains four fields 
separated by commas. The first field is the manufacturer’s name, the 
second field is the model number, the third field is the serial number, and 
the fourth field is a revision code which contains four numbers separated 
by dots and a fifth number separated by a dash:

Keysight Technologies, M8121A,<serial number>, 
x.x.x.x-h
x.x.x.x= Soft Front Panel revision number, e.g. 2.0.0.0

h= Hardware revision number

*CLS

Clear the event register in all register groups. This command also clears 
the error queue and cancels a *OPC operation. It doesn’t clear the enable 
register.

*ESE

Enable bits in the Standard Event Status Register to be reported in the 
Status Byte. The selected bits are summarized in the “Standard Event” bit 
(bit 5) of the Status Byte Register. The *ESE? query returns a value which 
corresponds to the binary-weighted sum of all bits enabled decimal by the 
*ESE command. These bits are not cleared by a *CLS command. Value 
Range: 0–255.

ESR?

Query the Standard Event Status Register. Once a bit is set, it remains set 
until cleared by a *CLS (clear status) command or queried by this 
command. A query of this register returns a decimal value which 
corresponds to the binary-weighted sum of all bits set in the register.

*OPC

Set the “Operation Complete” bit (bit 0) in the Standard Event register 
after the previous commands have been completed.
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*OPC?

Return “1” to the output buffer after the previous commands have been 
completed. Other commands cannot be executed until this command 
completes.

*OPT?

Read the installed options. The response consists of any number of fields 
separated by commas.

*RST

Reset instrument to its factory default state.

*SRE[?]

Enable bits in the Status Byte to generate a Service Request. To enable 
specific bits, you must write a decimal value which corresponds to the 
binary-weighted sum of the bits in the register. The selected bits are 
summarized in the “Master Summary” bit (bit 6) of the Status Byte 
Register. If any of the selected bits change from “0” to “1”, a Service 
Request signal is generated. The *SRE? query returns a decimal value 
which corresponds to the binary-weighted sum of all bits enabled by the 
*SRE command.

*STB?

Query the summary (status byte condition) register in this register group. 
This command is similar to a Serial Poll but it is processed like any other 
instrument command. This command returns the same result as a Serial 
Poll but the “Master Summary” bit (bit 6) is not cleared by the *STB? 
command.

*TST?

Execute Self Tests. If self-tests pass, a 0 is returned. A number lager than 0 
indicates the number of failed tests.

To get actual messages, use :TEST:TST?
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*LRN?

Query the instrument and return a binary block of data containing the 
current settings (learn string). You can then send the string back to the 
instrument to restore this state later. For proper operation, do not modify 
the returned string before sending it to the instrument. Use :SYST:SET to 
send the learn string. See :SYSTem:SET[?] on page 115.

*WAI?

Prevents the instrument from executing any further commands until the 
current command has finished executing.
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:ABOrt Commands

:ABORt[1|2]

Command :ABORt[1|2]
Parameters None

Parameter Suffix None

Description This command stops signal generation on channel. If channels are 
coupled, signal generation on both channels will be stopped.

Examples Command

:ABOR1
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:ARM Commands

:ARM[:SEQuence][:STARt][:LAYer]:DELay[1|2][?]

Command :ARM[:SEQuence]|[STARt][:LAYer]:DELay[1|2][?] <delay> 
| MINimum | MAXimum

Query :ARM[:SEQuence]|[STARt][:LAYer]:DELay[1|2]?
Parameters {<delay> | MINimum | MAXimum}

Parameter Suffix HZ

Description This command sets or queries the fine delay settings. The unit is in 
seconds.

Examples Command

:ARM:DEL1 2e-12 
Query

:ARM:DEL1? -> 2e-12

Table 6  Fine Delay Settings

:ARM[:SEQuence][:STARt][:LAYer]:CDELay[1|2][?] <coarse_delay>|MINimum|MAXi-
mum 

Command :ARM:CDEL[?]
Long :ARM[:SEQuence][:STARt][:LAYer]:CDELay[1|2][?] 

Parameters <coarse_delay> | MINimum | MAXimum

Parameter Suffix None

Description Set or query the coarse delay settings. The unit is in seconds. 

Examples Command 

:ARM:CDEL 3e-9 

Sample Frequency Fine Delay Range

fSa ≥ 6.25 GSa/s 0 .. 30e-12

2.5 GSa/s ≤ fSa < 6.25 GSa/s 0 .. 60e-12

fSa < 2.5 GSa/s 0 .. 150e-12
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Query

:ARM:CDEL? 

Table 7  Coarse Delay Settings

:ARM[:SEQuence][:STARt][:LAYer]:RNOisefloor[1 | 2][?] 

Command :ARM[:SEQuence][:STARt][:LAYer]:RNOisefloor[1 | 2] 
OFF|ON|0|1

Query :ARM[:SEQuence][:STARt][:LAYer]:RNOisefloor[1 | 2]?
Parameters OFF|ON|0|1

Parameter Suffix None

Description This command sets or queries the state of the “Reduced Noise Floor” 
feature. 

• 0/OFF – Noise reduction disabled. 

• 1/ON – Noise reduction enabled.

Examples Command

:ARM:RNO1 ON
Query

:ARM:RNO1? -> 1

Sample Frequency Coarse Delay Range Coarse Delay Resolution

fSa ≥ 6.25 GSa/s 0 .. 10e-9 10e-12

2.5 GSa/s ≤ fSa < 6.25 GSa/s 0 .. 10e-9 20e-12

fSa < 2.5 GSa/s 0 .. 10e-9 50e-12

NOTE
If the noise reduction is enabled and fine delay are constant and cannot 
be adjusted.
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:ARM[:SEQuence][:STARt][:LAYer]:TRIGger:IMPedance[?]

Command :ARM:TRIGger:IMPedance LOW|HIGH
Query :ARM:TRIGger:IMPedance?

Parameters LOW|HIGH

Parameter Suffix None

Description Set or query the trigger input impedance.

• LOW – low impedance

• HIGH – high impedance

Examples Command

:ARM:TRIG:IMP HIGH

Query

:ARM:TRIG:IMP? 

:ARM[:SEQuence][:STARt][:LAYer]:TRIGger:LEVel[?] 

Command :ARM:TRIGger:LEVel <level>|MINimum|MAXimum
Query :ARM:TRIGger:LEVel?

Parameters <level>|MINimum|MAXimum

Parameter Suffix None

Description Set or query the trigger input threshold level.

<level> – Threshold level voltage.

Examples Command

:ARM:TRIG:LEV 3e-9

Query

:ARM:TRIG:LEV?
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:ARM[:SEQuence][:STARt][:LAYer]:TRIGger:SLOPe[?] 

Command :ARM:TRIGger:SLOPe POSitive|NEGative|EITHer
Query :ARM:TRIGger:SLOPe?

Parameters POSitive|NEGative|EITHer

Parameter Suffix None

Description Set or query the trigger input slope.

• POSitive – rising edge

• NEGative – falling edge

• EITHer – both

Examples Command

:ARM:TRIG:SLOP POS

Query

:ARM:TRIG:SLOP?

:ARM[:SEQuence][:STARt][:LAYer]:TRIGger:STATus{1:2}?

Query :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:STATus{1:2}?
Description This query returns “1” after the trigger event is received, either from a 

trigger signal received at the front panel, or via the "Force Trigger" 
command 
(:TRIGger[:SEQuence][:STARt]:BEGin{1:2}[:IMMediate]/nquery/).

It returns 0 after playback is stopped (:ABOR).

Examples Query

:ARM:TRIG:STAT1?
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:TRIGger Commands

:TRIGger[:SEQuence][:STARt]:BEGin[1|2][:IMMediate]

Command :TRIG:BEG
Long :TRIGger:BEGin

Parameters None

Parameter Suffix None

Description In triggered mode send the start/begin event to a channel.

Examples Command

:TRIG:BEG
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:MARKer Commands

[:SOURce]:MARKer[1|2]:SAMPle:VOLTage[:LEVel][:IMMediate]:AMPLitude[?] <level>

Command :MARK:SAMP:VOLT:AMPL[?]
Long :MARKer:SAMPle:VOLTage:AMPLitude[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output amplitude for sample marker.

Examples Command

:MARK:SAMP:VOLT:AMPL 3.0e-9

Query

:MARK:SAMP:VOLT:AMPL?

[:SOURce]:MARKer[1|2]:SAMPle:VOLTage[:LEVel][:IMMediate]:HIGH[?] <level>

Command :MARK:SAMP:VOLT:HIGH[?]
Long :MARKer:SAMPle:VOLTage:HIGH[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output high level for sample marker.

Examples Command

:MARK:SAMP:VOLT:HIGH 1.5

Query

:MARK:SAMP:VOLT:HIGH?
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[:SOURce]:MARKer[1|2]:SAMPle:VOLTage[:LEVel][:IMMediate]:LOW[?] <level>

Command :MARK:SAMP:VOLT:LOW[?]
Long :MARKer:SAMPle:VOLTage:LOW[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output low level for sample marker.

Examples Command

:MARK:SAMP:VOLT:LOW -0.5

Query

:MARK:SAMP:VOLT:LOW?

[:SOURce]:MARKer[1|2]:SAMPle:VOLTage[:LEVel][:IMMediate]:OFFSet[?] <level>

Command :MARK:SAMP:VOLT:OFFS[?]
Long :MARKer:SAMPle:VOLTage:OFFSet[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output offset for sample marker.

Examples Command

:MARK:SAMP:VOLT:OFFS 2.5e-9

Query

:MARK:SAMP:VOLT:OFFS?
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[:SOURce]:MARKer[1:2]:VECTor:VOLTage[:LEVel][:IMMediate]:AMPLitude <level>

Command :MARK:VECT:VOLT:AMPL[?]
Long :MARKer:VECT:VOLTage:AMPLitude[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output amplitude for vector marker.

Examples Command

:MARK:VECT:VOLT:AMPL 2.5e-9

Query

:MARK:VECT:VOLT:AMPL?

[:SOURce]:MARKer[1:2]:VECTor:VOLTage[:LEVel][:IMMediate]:HIGH <level>

Command :MARK:VECT:VOLT:HIGH[?]
Long :MARKer:VECT:VOLTage:HIGH[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output high level for vector marker.

Examples Command

:MARK:VECT:VOLT:HIGH 1.5

Query

:MARK:VECT:VOLT:HIGH?
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[:SOURce]:MARKer[1:2]:VECTor:VOLTage[:LEVel][:IMMediate]:LOW <level>

Command :MARK:VECT:VOLT:LOW[?]
Long :MARKer:VECT:VOLTage:LOW[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output low level for vector marker.

Examples Command

:MARK:VECT:VOLT:LOW -0.5

Query

:MARK:VECT:VOLT:LOW?

[:SOURce]:MARKer[1:2]:VECTor:VOLTage[:LEVel][:IMMediate]:OFFSet <level>

Command :MARK:VECT:VOLT:OFFS[?]
Long :MARKer:VECT:VOLTage:OFFSet[?]

Parameters <level>

Parameter Suffix None

Description Set or query the output offset for vector marker.

Examples Command

:MARK:VECT:VOLT:OFFS 2.5e-9

Query

:MARK:VECT:VOLT:OFFS?
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:INITiate Commands

:INITiate:IMMediate[1|2]

Command :INITiate:IMMediate[1|2]
Parameters None

Parameter Suffix None

Description This command starts signal generation on a channel or arms the channel 
in triggered mode. If channels are coupled, the signal generation on both 
the channels will start. 

Examples Command

:INIT:IMM1

:INITiate:CONTinous[1|2][:STATe][?] OFF|ON|0|1

Command :INIT:CONT[1|2]:STAT[?]
Long :INITiate:CONTinuous[1|2]:STATe[?]

Parameters ON: Continuous

OFF: Triggered

Parameter Suffix None

Description This command is used to set or query the continuous mode, or to set the 
triggered mode.

0/OFF – Continuous mode is off.

1/ON – Continuous mode is on. Trigger mode is “automatic”.

Examples Command

:INIT:CONT:STAT ON

Query

:INIT:CONT:STAT?
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:INSTrument Commands

:INSTrument:COUPle:STATe[1|2][?]

Command :INSTrument:COUPle:STATe[1|2] OFF|ON|0|1
Query :INSTrument:COUPle:STATe[1|2]?

Parameters OFF|ON|0|1
Parameter Suffix None

Description This command switch coupling on/off. Coupled mode means both 
channels are synchronized. If coupling is switched from on to off, the 
values of the channel where coupling is switched on are taken. The 
coupled values are:

:TRAC[1|2]:DWID
Examples Command

:INST:COUP:STAT1 ON
Query

:INST:COUP:STAT1?

:INSTrument:SLOT[:NUMBer]? 

Query :INSTrument:SLOT[:NUMBer]?
Parameters None

Parameter Suffix None

Description This query returns the instrument’s slot number in its AXIe frame.

Examples Query

:INST:SLOT?



Keysight M8121A Arbitrary Waveform Generator User Guide 93

Remote Programming 6

 

:MMEMory Commands

This node provides access to parts of the remote host file system, so that 
waveform files can be loaded from the remote host into the module.

:MMEMory:LOAD:CSTate 

Command :MMEMory:LOAD:CSTate <file_name>
Parameters <file_name>

Parameter Suffix None

Description This command loads the saved configuration file to the instrument.

Examples Command

:MMEM:LOAD:CST "C:\data.txt"

:MMEMory:STORe:CSTate 

Command :MMEMory:STORe:CSTate <file_name>
Parameters <file_name>

Parameter Suffix None

Description This command stores the current state of instrument to a file.

Examples Command

:MMEM:STOR:CST "C:\data.txt"
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:OUTPut Commands

:OUTPut[1|2]:COMPlement[:STATe][?]

Command :OUTPut[1|2]:COMPlement[:STATe] OFF|ON|0|1
Query :OUTPut[1|2]:COMPlement[:STATe]?

Parameters OFF|ON|0|1
Parameter Suffix None

Description This command switch the complement output on or off.

Examples Command

:OUTP:COMP ON
Query

:OUTP:COMP? -> 1

:OUTPut[1|2]:DIOFfset[?]

Command :OUTPut[1|2]:DIOFfset <value>|MINimum|MAXimum
Query :OUTPut[1|2]:DIOFfset? 

Parameters <value>|MINimum|MAXimum
Parameter Suffix None

Description This command sets the differential offset. The hardware can compensate 
for little offset differences between the normal and complement output. 
“<value>” is the offset to the calibrated optimum DAC value, so the 
minimum and maximum depend on the result of the calibration.

Examples Command

:OUTP:DIOF MAX
Query

:OUTP:DIOF?
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:OUTPut[1|2][:NORMal][:STATe][?] 

Command :OUTPut[1|2][:NORMal][:STATe] OFF|ON|0|1
Query :OUTPut[1|2][:NORMal][:STATe]?

Parameters OFF|ON|0|1
Parameter Suffix None

Description This command switch (normal) output on or off.

Examples Command

:OUTP:NORM ON
Query

:OUTP:NORM? -> 1

:OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC 

Command :OUTPut[1|2]:ROUTe[:SELect] DAC|DC
Query :OUTPut[1|2]:ROUTe[:SELect]? 

Parameters DAC|DC
Parameter Suffix None

Description This command selects the output path:

• DAC: Direct DAC output

• DC: Amplified differential output

Examples Command

:OUTP:ROUT DAC
Query

:OUTP:ROUT?
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:SOURce Commands

[:SOURce]:DAC|DC[1|2]:FORMat[?]

Command [:SOURce]:DAC|DC[1|2]:FORMat DNRZ|NRZ|DOUBlet
Query [:SOURce]:DAC|DC[1|2]:FORMat? 

Parameters DNRZ|NRZ|DOUBlet
Parameter Suffix None

Description This command sets or queries the DAC format mode.

Examples Command

:DAC:FORM DNRZ
Query

:DAC:FORM? -> DNRZ

[:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:AMPLitude[?]

Command Syntax [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:AMP
Litude <level>

Query Syntax [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:AMP
Litude? 

Parameters <level>
Parameter Suffix None

Description This command sets or queries the amplitude for the DAC or DC output 
path, as specified in the SCPI command. 
The output path can also be set using the OUTP:ROUT:SEL command 
(see :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95). 

Examples Command

:DAC:VOLT:AMPL 0.685
Query

:DAC:VOLT:AMPL?
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[:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:HIGH[?]

Command Syntax [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:HIG
H <level>

Query Syntax [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:HIG
H? 

Parameters <level>
Parameter Suffix None

Description This command sets or queries the high level for the DAC or DC output 
path, as specified in the SCPI command. 
The output path can also be set using the OUTP:ROUT:SEL command 
(see :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95). 

Examples Command

:DAC:VOLT:HIGH 3e-1
Query

:DAC:VOLT:HIGH?

[:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:LOW[?]

Command [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:LOW 
<level>

Query [:SOURce]:DAC|DC[1|2]:VOLTage[:LEVel][:IMMediate]:LOW
? 

Parameters <level>
Parameter Suffix None

Description This command sets or queries the low level for the DAC or DC output 
path, as specified in the SCPI command. 
The output path can also be set using the OUTP:ROUT:SEL command 
(see :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95). 

Examples Command

:DAC:VOLT:LOW -0.3
Query

:DAC:VOLT:LOW?
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[:SOURce]:DC[1|2]:VOLTage[:LEVel][:IMMediate]:TERMination[?]

Command [:SOURce]:DC[1|2]:VOLTage[:LEVel][:IMMediate]:TERMina
tion <level>

Query [:SOURce]:DC[1|2]:VOLTage[:LEVel][:IMMediate]:TERMina
tion?

Parameters <level>
Parameter Suffix None

Description This command sets or queries the termination voltage level.

Examples Command

:DC:VOLT:TERM 3e-1
Query

:DC:VOLT:TERM?

[:SOURce]:VOLTage[:LEVel][:IMMediate]:OFFSet[?]

Command [:SOURce]:VOLTage[:LEVel][:IMMediate]:OFFSet <level>
Query [:SOURce]:VOLTage[:LEVel][:IMMediate]:OFFSet?

Parameters <level>
Parameter Suffix None

Description This command sets or queries the output offset.

Examples Command

:VOLT:OFFS 0.02
Query

:VOLT:OFFS?
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[:SOURce]:CARRier[1|2]:FREQuency[?]

Command [:SOURce]:CARRier[1|2]:FREQuency 
<frequency_integral>[,<frequency_fractional>]|DEFault

Query [:SOURce]:CARRier[1|2]:FREQuency? 
Parameters <frequency_fractional>]|DEFault

Parameter Suffix Hz

Description This command sets or queries the carrier frequency used for interpolated 
modes. The command form expects an integral value in the range 
[0 .. 12] GHz and a fractional value in the range [0,1) Hz. To query the 
minimum and maximum values use the following two commands. 
[:SOURce]:CARRier[1|2]:FREQuency:INTegral[?] 
[<frequency_integral>|MIN|MAX|DEFault] and 
[:SOURce]:CARRier[1|2]:FREQuency:FRACtional[?] 
[<frequency_fractional>|MIN|MAX|DEFault.
• <frequency_integral> – Integral part of the carrier frequency (in 

Hz)

• <frequency_fractional> – Fractional part of the carrier 
frequency (optional, defaults to 0.0)

Examples Command

:CARR1:FREQ 1e9,0.5
This command sets the carrier frequency to 1.0000000005GHz (1GHz + 
0.5Hz).

Query

:CARR1:FREQ?

[:SOURce]:CARRier[1|2]:FREQuency:FRACtional[?]

Command [:SOURce]:CARRier[1|2]:FREQuency:FRACtional 
<frequency_fractional>|MIN|MAX|DEFault

Query [:SOURce]:CARRier[1|2]:FREQuency:FRACtional?
Parameters <frequency_fractional> | MIN | MAX | DEFault

Parameter Suffix Hz

Description This command sets or queries the fractional part of the carrier frequency 
used for interpolated modes.

<frequency_fractional> – Fractional part of the carrier frequency
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Examples Command

:CARR1:FREQ:FRAC 1e-9
Query

:CARR1:FREQ:FRAC?

[:SOURce]:CARRier[1|2]:FREQuency:INTegral[?]

Command [:SOURce]:CARRier[1|2]:FREQuency:INTegral[?] 
<frequency_integral>|MIN|MAX|DEFaultetegral>|MIN|MAX|DEFault

Query [:SOURce]:CARRier[1|2]:FREQuency:INTegral[?] 
<frequency_integral>|MIN|MAX|DEFault

Parameters <frequency_integral> | MIN | MAX | DEF
Parameter Suffix None

Description This command sets or queries the integral part of the carrier frequency 
used for interpolated modes.

<frequency_integral> – Integral part of the carrier frequency (in Hz)

Examples Command

:CARR1:FREQ:INT 1e9
Query

:CARR1:FREQ:INT?

[:SOURce]:CARRier[1|2]:POFFset [?]

Command [:SOURce]:CARRier[1|2]:POFFset <phase- offset> 
|MINimum|MAXimum|DEFaultency_integral>|MIN|MAX|DEFaul
t

Query [:SOURce]:CARRier[1|2]:POFFset? 
Parameters <phase-offset> | MIN | MAX | DEF

Parameter Suffix None

Description This command sets or queries the carrier phase offset used for 
interpolated modes.
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Examples Command

:CARR1:POFF 0.1
This command sets the carrier phase offset to 0.1 cycles.

Query

:CARR1:POFF?

[:SOURce]:CARRier[1|2]:SCALe[?]

Command [:SOURce]:CARRier[1|2]:SCALe 
<scale>|MINimum|MAXimum|DEFaultency_integral>|MIN|MAX
|DEFault

Query [:SOURce]:CARRier[1|2]:SCALe?
Parameters <scale> | MIN | MAX | DEF

Parameter Suffix None

Description This command sets or queries the amplitude scale used for interpolated 
modes.

Examples Command

:CARR1:SCAL 0.9
This command sets the carrier amplitude scale to 0.9.

Query

:CARR1:SCAL? -> 0.9

[:SOURce]:FREQuency:RASTer[?]

Command [:SOURce]:FREQuency:RASTer 
<frequency>|MINimum|MAXimumency_integral>|MIN|MAX|DEF
ault

Query [:SOURce]:FREQuency:RASTer?
Parameters <frequency>|MINimum|MAXimum

Parameter Suffix None
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Description This command is used to set or query the sample clock frequency.

Examples Command

:FREQ:RAST 2e9
Query

:FREQ:RAST?

[:SOURce]:FREQuency:RASTer:EXTernal[?]

Command [:SOURce]:FREQuency:RASTer:EXTernal 
<frequency>|MINimum|MAXimumency_integral>|MIN|MAX|DEF
ault

Query [:SOURce]:FREQuency:RASTer:EXTernal?
Parameters <frequency>|MINimum|MAXimum

Parameter Suffix None

Description This command sets or queries the external sample frequency. The internal 
sample clock fSa,i is derived from the sample clock provided at SCLK IN. 
For fSa,i = 500 MSa/s…1 GSa/s the sample clock input must be twice of 
fSa,i. 
For fSa,i = 250 MSa/s…500 MSa/s the sample clock input must be four 
times fSa,i. 
For fSa,i = 125 MSa/s…250 MSa/s the sample clock input must be eight 
times fSa,i.

Examples Command

:FREQ:RAST:EXT MIN
Query

:FREQ:RAST:EXT?
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[:SOURce]:FREQuency:RASTer:SOURce[?]

Command [:SOURce]:FREQuency:RASTer:SOURce 
INTernal|EXTernal|LPNoise

Query [:SOURce]:FREQuency:RASTer:SOURce?
Parameters INTernal|EXTernal|LPNnoise

Parameter Suffix None

Description This command sets or queries the selected clock source for the module. 
When switching to EXTernal a stable sample clock that matches the 
frequency set with must be supplied at SCLK IN.

Examples Command

:FREQ:RAST:SOUR INT
Query

:FREQ:RAST:SOUR?

[:SOURce]:FREQuency:RASTer:STATus[1:2]?

Query [:SOURce]:FREQuency:RASTer:STATus[1:2]?
Parameters None

Parameter Suffix None

Description This queries the status of clock stability for each channel. It reflects the 
Clock LED status on the soft front panel.

Examples Query

FREQ:RAST:STAT1?

NOTE
External is the LPN Clk In and therefore this command replaces 
[:SOURce]:FREQuency:RASTer:LPNoise, 
[:SOURce]:FREQuency:RASTer:LPNoise:ACTive, 
[:SOURce]:FREQuency:RASTer:LPNoise:ENABle
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[:SOURce]:FUNCtion[1|2]:MODE[?]

Command [:SOURce]:FUNCtion[1|2]:MODE <INTernal|OPTical>
Parameters INTernal|OPTical

Parameter Suffix None

Description This command sets or queries the source of the waveform data.

Examples Command

:FUNC1:MODE:INT 
Query

:FUNC1:MODE:INT?

[:SOURce]:ROSCillator:FREQuency[?]

Command [:SOURce]:ROSCillator:FREQuency 
<frequency>|MINimum|MAXimum

Query [:SOURce]:ROSCillator:FREQuency?
Parameters <frequency>|MINimum|MAXimum

Parameter Suffix None

Description This command sets or queries the expected reference clock frequency, if 
the external reference clock source is selected.

Examples Command

:ROSC:FREQ MIN
Query

:ROSC:FREQ?
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[:SOURce]:ROSCillator:SOURce[?]

Command [:SOURce]:ROSCillator:SOURce EXTernal|AXI|INTernal
Query [:SOURce]:ROSCillator:SOURce?

Parameters EXTernal|AXI|INTernal
Parameter Suffix None

Description This command sets or queries the reference clock source.

EXTernal: reference is taken from REF CLK IN.

AXI: reference is taken from AXI backplane.

INTernal: module internal reference.

Examples Command

:ROSC:SOUR AXI
Query

:ROSC:SOUR?

[:SOURce]:VOLTage[1|2][:LEVel][:IMMediate][:AMPLitude][?]

Command [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate][:AMPLitude
] <level>

Query [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate][:AMPLitude
]?

Parameters <level>
Parameter Suffix None

Description This command sets or queries the amplitude for the currently selected 
output path (DAC or DC, selected with the OUTP:ROUT:SEL command). 
See :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95.

Examples Command

:VOLT 0.685
Query

:VOLT?
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[:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:HIGH[?]

Command [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:HIGH 
<level>

Query [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:HIGH?
Parameters <level>

Parameter Suffix None

Description This command sets or queries the high level for the currently selected 
output path (DAC or DC, selected with the OUTP:ROUT:SEL command). 
See :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95.

Examples Command

:VOLT:HIGH 3e-1
Query

:VOLT:HIGH?

[:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:LOW[?]

Command [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:LOW 
<level>

Query [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:LOW?
Parameters <level>

Parameter Suffix None

Description This command sets or queries the low level for the currently selected 
output path (DAC or DC, selected with the OUTP:ROUT:SEL command). 
See :OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95.

Examples Command

:VOLT:LOW -0.3
Query

:VOLT:LOW?
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[:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:OFFSet[?]

Command [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:OFFSet 
<level>

Query [:SOURce]:VOLTage[1|2][:LEVel][:IMMediate]:OFFSet?
Parameters <level>

Parameter Suffix None

Description This command sets or queries the offset for the currently selected output 
path (DAC or DC, selected with the OUTP:ROUT:SEL command). See 
:OUTPut[1|2]:ROUTe[:SELect][?] DAC|DC on page 95.

Examples Command

:VOLT:OFFS 0.02
Query

:VOLT:OFFS?
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:STATus Commands

The Operation Status register contains conditions which are part of the 
instrument’s normal operation.

The following commands access the operation status group.

:STATus:OPERation[:EVENt]?

Reads the event register in the operation status group. It’s a read-only 
register. Once a bit is set, it remains set until cleared by this command or 
*CLS command. A query of the register returns a decimal value which 
corresponds to the binary-weighted sum of all bits set in the register.

:STATus:OPERation:CONDition?

Reads the condition register in the operation status group. It’s a read-only 
register and bits are not cleared when you read the register. A query of the 
register returns a decimal value which corresponds to the binary-weighted 
sum of all bits set in the register.

:STATus:OPERation:ENABle[?]

Sets or queries the enable register in the operation status group. The 
selected bits are then reported to the Status Byte. A *CLS will not clear the 
enable register but it does clear all bits in the event register. To enable bits 
in the enable register, you must write a decimal value which corresponds 
to the binary-weighted sum of the bits you wish to enable in the register.

:STATus:OPERation:NTRansition[?]

Sets or queries the negative-transition register in the operation status 
group. A negative transition filter allows an event to be reported when a 
condition changes from true to false. Setting both positive/negative filters 
true allows an event to be reported anytime the condition changes. 
Clearing both filters disable event reporting. The contents of transition 
filters are unchanged by *CLS and *RST.

:STATus:OPERation:PTRansition[?]

Set or queries the positive-transition register in the operation status 
group. A positive transition filter allows an event to be reported when a 
condition changes from false to true. Setting both positive/negative filters 
true allows an event to be reported anytime the condition changes. 
Clearing both filters disable event reporting. The contents of transition 
filters are unchanged by *CLS and *RST.
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:STATus:PRESet

Clears all status group event registers. Presets the status group enables 
PTR and NTR registers as follows:

ENABle = 0x0000, PTR = 0xffff, NTR = 0x0000



110 Keysight M8121A Arbitrary Waveform Generator User Guide

6 Remote Programming
 

:QUEStionable Commands

The Questionable Data register group provides information about the 
quality or integrity of the instrument. Any or all of these conditions can be 
reported to the Questionable Data summary bit through the enable 
register.

The following commands access the questionable status group.

:STATus:QUEStionable[:EVENt]?

Reads the event register in the questionable status group. It’s a read-only 
register. Once a bit is set, it remains set until cleared by this command or 
the *CLS command. A query of the register returns a decimal value which 
corresponds to the binary-weighted sum of all bits set in the register.

:STATus:QUEStionable:CONDition?

Reads the condition register in the questionable status group. It’s a 
read-only register and bits are not cleared when you read the register. A 
query of the register returns a decimal value which corresponds to the 
binary-weighted sum of all bits set in the register.

:STATus:QUEStionable:ENABle[?]

Sets or queries the enable register in the questionable status group. The 
selected bits are then reported to the Status Byte. A *CLS will not clear 
the enable register but it does clear all bits in the event register. To enable 
bits in the enable register, you must write a decimal value which 
corresponds to the binary-weighted sum of the bits you wish to enable in 
the register.

:STATus:QUEStionable:NTRansition[?]

Sets or queries the negative-transition register in the questionable status 
group. A negative transition filter allows an event to be reported when a 
condition changes from true to false. Setting both positive/negative filters 
true allows an event to be reported anytime the condition changes. 
Clearing both filters disable event reporting. The contents of transition 
filters are unchanged by *CLS and *RST.

:STATus:QUEStionable:PTRansition[?]

Set or queries the positive-transition register in the questionable status 
group. A positive transition filter allows an event to be reported when a 
condition changes from false to true. Setting both positive/negative filters 
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true allows an event to be reported anytime the condition changes. 
Clearing both filters disable event reporting. The contents of transition 
filters are unchanged by *CLS and *RST.
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:SYSTem Commands

:SYSTem:COMMunicate:INSTr[:NUMBer]?

Query :SYSTem:COMMunicate:INSTr[:NUMBer]?
Parameters None

Parameter Suffix None

Description This query returns the VXI-11 instrument number used by the firmware.

Examples Query

:SYST:COMM:INST?

:SYSTem:COMMunicate:HISLip[:NUMBer]?

Query :SYSTem:COMMunicate:HISLip[:NUMBer]?
Parameters None

Parameter Suffix None

Description This query returns the HiSLIP number used by the firmware.

Examples Query

:SYST:COMM:HISL?

:SYSTem:COMMunicate:SOCKet[:PORT]?

Query :SYSTem:COMMunicate:SOCKet[:PORT]?
Parameters None

Parameter Suffix None

Description This query returns the socket port used by the firmware.

Examples Query

:SYST:COMM:SOCK?
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:SYSTem:COMMunicate:TCPip:CONTrol?

Query :SYSTem:COMMunicate:TCPip:CONTrol?
Parameters None

Parameter Suffix None

Description This query returns the port number of the control connection. You can use 
the control port to send control commands (for example “Device Clear”) to 
the instrument.

Examples Query

:SYST:COMM:TCP:CONT?

:SYSTem:COMMunicate:TELNet[:PORT]?

Query :SYSTem:COMMunicate:TELNet[:PORT]?
Parameters None

Parameter Suffix None

Description This query returns the telnet port used by the firmware.

Examples Query

:SYST:COMM:TELN?

:SYSTem:ERRor:COUNT?

Query :SYSTem:ERRor:COUNT?
Parameters None 

Parameter Suffix None

Description This query returns the error count. 

Examples Query

:SYST:ERR:COUNT?
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:SYSTem:ERRor[:NEXT]?

Query :SYSTem:ERRor[:NEXT]?
Parameters None 

Parameter Suffix None

Description Read and clear one error from the instrument’s error queue.

A record of up to 30 command syntax or hardware errors can be stored in 
the error queue. Errors are retrieved in first-in-first-out (FIFO) order. The 
first error returned is the first error that was stored. Errors are cleared as 
you read them.

If more than 30 errors have occurred, the last error stored in the queue 
(the most recent error) is replaced with “Queue overflow”. No additional 
errors are stored until you remove errors from the queue.

If no errors have occurred when you read the error queue, the instrument 
responds with 0,“No error”.

The error queue is cleared by the *CLS command, when the power is 
cycled, or when the firmware is re-started.

The error queue is not cleared by a reset (*RST) command.

The error messages have the following format (the error string may contain 
up to 255 characters):

error number,”Description”, e.g.

-113,”Undefined header”.

Examples Query

:SYST:ERR?

:SYSTem:HELP:HEADers?

Query :SYSTem:HELP:HEADers?
Parameters None

Parameter Suffix None

Description The HEADers? query returns all SCPI commands and queries and IEEE 
488.2 common commands and common queries implemented by the 
instrument. The response is a <DEFINITE LENGTH ARBITRARY BLOCK 
RESPONSE DATA> element. The full path for every command and query is 
returned separated by line feeds. The syntax of the response is defined as: 
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The <nonzero digit> and sequence of <digit> follow the rules in IEEE 488.2, 
Section 8.7.9. An <SCPI header> is defined as: It contains all the nodes 
from the root. The <SCPI program mnemonic> contains the node in 
standard SCPI format. The short form uses uppercase characters while the 
additional characters for the long form are in lowercase characters. 
Default nodes are surrounded by square brackets ([]).

Examples Query

:SYST:HELP:HEAD?

:SYSTem:LICense:EXTended:LIST?

Query :SYSTem:LICense:EXTended:LIST?
Parameters None

Parameter Suffix None

Description This query lists the licenses installed.

Examples Query

:SYST:LIC:EXT:LIST?

:SYSTem:SET[?]

Command :SYSTem:SET <binary block data>
Query :SYSTem:SET?

Parameters <binary block data>
Parameter Suffix None

Description In query form, the command reads a block of data containing the 
instrument’s complete set-up. The set-up information includes all 
parameter and mode settings, but does not include the contents of the 
instrument setting memories or the status group registers. The data is in a 
binary format, not ASCII, and cannot be edited.

In set form, the block data must be a complete instrument set-up read 
using the query form of the command.

This command has the same functionality as the *LRN command.

Examples Command

:SYST:SET <binary block data>
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Query

:SYST:SET?

:SYSTem:VERSion?

Query :SYSTem:VERSion?
Parameters None

Parameter Suffix None

Description This query returns a formatted numeric value corresponding to the SCPI 
version number for which the instrument complies.

Examples Query

:SYST:VERS?
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:TRACe Commands

:TRACe commands should be used when working with the M8121A 
internal memory. With the exception of the :TRACe[1|2]:DWIDth[?] 
command, they do not apply when streaming data over the ODI port.

Use the :TRACe subsystem to control the arbitrary waveforms and their 
respective parameters:

• Select the DAC width in direct mode and the interpolation factor in 
interpolated mode.

• Create waveform segments of arbitrary size with optional initialization.

• Download waveform data into memory.

• Delete data from the waveform memory.

Direct and Interpolated Mode

In direct mode, arbitrary waveforms are generated directly from the DAC 
values in the waveform data. Each DAC value has a resolution of 12 bits or 
14 bits.

In interpolated mode the waveform data consists of I/Q sample pairs. They 
are first interpolated and then sent to the internal IQ modulator. The result 
is sent to the DAC. I and Q values have a size of 15 bits each. 

Waveform Memory Capacity

DAC values and I/Q samples are stored in a dedicated waveform memory. 
The capacity of this memory in samples depends on the waveform output 
mode and the installed memory option. The waveform memory size is 
1,048,576 bytes, but the maximum number of samples is dictated not only 
by the memory size but also the waveform granularity discussed in the 
next section.

NOTE
:TRACe commands must follow the waveform length rules as outlined in 
the Data Source Tab section.
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Table 8  Waveform Memory Capacity

Waveform Granularity and Size

The waveform memory is internally organized in fixed size memory vectors. 
Their size depends on the selected waveform output mode. The waveform 
length must be multiples of the memory vector size. The maximum 
segment size is only limited by the size of the available memory.

Table 9  Waveform Granularity and Size

Waveform Data Format in Direct Mode

DAC values have 14 or 12 bit resolution. DAC values are signed. Valid 
range is -8192 to +8191 in 14-bit mode and -2048 to 2047 in 12-bit mode.

Marker position data consists of two bits, one bit for sample markers 
(SMPM) and one bit for sync markers (SYNM). The marker position data is 
stored together with the DAC values in a 16-bit signed integer. The DAC 
values occupy the most significant bits and the marker data the least 
significant bits. In 12-bit mode bits 2 and 3 are don’t-care. The same data 
format can be used for both modes. In speed mode the two least 
significant bits are simply ignored.

Waveform output mode and packing Number of Samples

12-bit, stored in 16-bit words 524,160

14-bit, stored in 16-bit words 524,160

12-bit stored in 12-bit “packed” words 523,776

xN interpolation 262,144

Waveform output mode Memory vector size in samples

12-bit, stored in 16-bit words 192

14-bit, stored in 16-bit words 320

12-bit stored in 12-bit “packed” words 768

xN interpolation 64
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Only the sync marker bit in the first sample of each memory vector is used. 
Sync marker bits in the other samples are ignored.

DAC Value binary format in 14-bit mode:

DAC Value binary format in 12-bit mode:

The 12-bit packed format is useful to mimic the data format needed when 
sending data over the ODI to the M8121A in 12-bit mode. The packing is 
required in order to fit within the data bandwidth of the ODI. When using 
the 12-bit packed format, there are no marker bits.

DAC Value binary format in 12-bit packed mode:

Waveform Data Format in Interpolated Mode

I and Q values have 15 bit resolution in interpolated mode. I and Q values 
are signed. Valid range is -16384 to +16383.

Marker position data consists of one bit for a sample marker (SMPM) and 
one bit for a sync marker (SYNM) for each I/Q sample pair. The 24 I and Q 
samples are stored interlaced. The marker position data is stored together 
with I and Q values in two 16-bit signed integers.

Only the sync marker bit in the first sample of each memory vector is used. 
Sync marker bits in the other samples are ignored.

The same data format can be used for all four interpolated modes (x3, x12, 
x24 and x48).

I/Q value binary format in interpolated mode:

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

DB13 DB12 DB11 DB10 DB9 DB8 DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 SYNM SMPM

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

DB11 DB10 DB9 DB8 DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 X X SYNM SMPM
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Arbitrary Waveform Generation

To prepare your module for arbitrary waveform generation follow these 
steps:

1 Select one of the direct modes (12- or 14-bit) or one of the 
interpolated modes ((x3, x12, x24 and x48) using 
:TRACe[1|2]:DWIDth

2 Define the waveform using the various forms of the :TRAC[1|2]:DEF 
command

3 Fill the memory with values and marker data using 
:TRAC[1|2]:DATA

4 Signal generation starts after calling INIT:IMM

:TRACe[1|2]:COMMent[?]

Command :TRACe[1|2]:COMMent[?] <segment_id>,<comment>
Query :TRACe[1|2]:COMMent?

Parameters <segment_id>,<comment>
Parameter Suffix None

Description This command associates a comment to a segment. The query gets the 
comment for a segment.

<segment_id> – id of the segment, must be 1.

<comment> – string of at most 256 characters

Examples Command

:TRAC:COMM 1, “Comment”
Query

:TRAC:COMM? 1

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

I14 I13 I12 I11 I10 I9 I8 I7 I6 I5 I4 I3 I2 I1 I0 SMPM

Q14 Q13 Q12 Q11 Q10 Q9 Q8 Q7 Q6 Q5 Q4 Q3 Q2 Q1 Q0 SYNM
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:TRACe[1|2][:DATA][?] <segment_id>,<offset>,(<length>|<block>|<numeric_values>)

Command :TRACe[1|2][:DATA] 
<segment_id>,<offset>,(<length>|<block>|<numeric_valu
es>)

Query :TRACe[1|2][:DATA]? <segment_id>,<offset>,<length>
Parameters <segment_id>,<offset>,(<length>|<block>|<numeric_valu

es>)
• <segment_id> – id of the segment, must be 1

• <offset> offset in samples for direct modes and I/Q sample pairs for 
interpolated modes to allow splitting the transfer in smaller portions. 
The offset parameter is necessary to overcome the SCPI restriction that 
only allows transferring up to 999999999 bytes at once.

• <block> waveform data samples and marker values in the data format 
described above in IEEE binary block format

• <numeric_values> waveform data samples and marker values in 
the data format described above in comma separated list format; each 
element is a 16-bit integer values representing DAC samples and 
marker data Di in direct modes or I/Q samples and marker data Ii, Qi in 
interpolated modes.

• Direct mode: D0, D1, D2,...

• Interpolated mode: I0, Q0, I1, Q1, I2, Q2…

Parameter Suffix None

Description Use this command to load waveform and marker data into the module 
memory. If <segment_id> is already filled with data, the new values 
overwrite the current values. If length is exceeded error -223 (too much 
data) is reported.

Examples Command

Load data consisting of 320 samples as comma-separated list into 
previously defined segment 1 starting at sample offset 0.

:TRAC1:DATA 1,0,0,1,2,…,319
Query

:TRAC:DATA? 1,0,48
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:TRACe[1|2]:DEFine[?]

Command :TRACe[1|2]:DEFine 
<segment_id>,<length>[,<init_value1>[,<init_value2>]]

Query :TRACe[1|2]:DEFine?
Parameters <segment_id>,<length>[,<init_value1>[,<init_value2>]]

• <segment_id> – id of the segment, must be 1.

• <length> – length of the segment in samples for direct modes or in 
I/Q sample pairs for interpolated modes.

• <init_value1> – optional initialization value. For direct modes this 
is a DAC value. For interpolated modes this is the I-part of an I/Q 
sample pair.

• <init_value2> – optional initialization value, only applicable for 
interpolated modes. This is the Q-part of an I/Q sample pair.

Parameter Suffix None

Description Use this command to define the size of a waveform memory segment. If is 
specified (direct modes) or and (interpolated modes) are specified, all 
sample values in the segment are initialized. If not specified, memory is 
only allocated but not initialized. The segment will be flagged write-only, 
so it cannot be read back or stored.

Examples Commands

To set precision mode

:TRAC1:DWID WPR
To define a segment with id 1 and length 320 samples. Initialize to sample 
value 0.

:TRAC1:DEF 1,320,0
To set interpolated mode, interpolation factor 3.

:TRAC1:DWID INTX3
To define a segment with id 1 and length 64 samples. Initialize with I/Q 
value pair (0,1).

:TRAC:DEF 1,64,0,1
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:TRACe[1|2]:DEFine:NEW?

Command

Query :TRACe[1|2]:DEFine:NEW? <length> 
[,<init_value1>[,<init_value2>]]

Parameters <length> [,<init_value1>[,<init_value2>]]
• <length> – length of the segment in samples for direct modes or in 

I/Q sample pairs for interpolated modes

• <init_value1> – optional initialization value. For direct modes this 
is a DAC value. For interpolated modes this is the I-part of an I/Q 
sample pair.

• <init_value2> – optional initialization value, only applicable for 
interpolated modes. This is the Q-part of an I/Q sample pair.

Parameter Suffix None

Description Use this query to define the size of a waveform memory segment. If 
<init_value1> is specified (direct modes) or <init_value1> and <init_value2> 
(interpolated modes) are specified, all sample values in the segment are 
initialized. If not specified, memory is only allocated but not initialized. If 
the query was successful, a new <segment_id> will be returned.

This query returns a segment ID of 1 every time, unless the allocation fails.

It always removes the existing segment #1 and creates a new one of the 
specified size, returning ID=1.

Examples Query

Define a segment of length 320 samples. Returns the segment id.

:TRAC1:DEF:NEW? 320

:TRACe[1|2]:DWIDth[?]

Command :TRACe[1|2]:DWIDth[?] 
WSPeed|WPRecision|INTX3|INTX12|INTX24|INTX48

Query :TRACe[1|2]:DWIDth?
Parameters WSPeed|WPRecision|INTX3|INTX12|INTX24|INTX48

• WSPeed – speed mode, 12 bit DAC resolution

• WPRecision – precision mode, 14 bit DAC resolution

• INTX3 – interpolation x3 mode

• INTX12 – interpolation x12 mode
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• INTX24 – interpolation x24 mode

• INTX48 – interpolation x48 mode

Parameter Suffix None

Description Use this command or query to set or get the waveform output mode. If the 
DAC resolution is changed in direct mode or if there is a switch from direct 
mode to interpolated mode or vice versa, all waveform segments for this 
channel are invalidated.

The interpolated modes INTX3, INTX12, INTX24 and INTX48 are only 
available when the DUC option is installed.

Note that although this command is channelized, the output mode must 
remain the same for both channels. Changing one channel will change the 
other to be the same.

Examples Command

:TRAC:DWID INTX3
Query

:TRAC:DWID?

:TRACe[1|2]:DELete

Command :TRACe[1|2]:DELete <segment_id>
Query

Parameters <segment_id>
Parameter Suffix None

Description <segment_id> – id of the segment, must be 1.

Delete a segment. The command can only be used in program mode.

Examples Command

:TRAC:DEL 5

:TRACe[1|2]:DELete:ALL

Command :TRACe[1|2]:DELete:ALL
Query

Parameters None
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Parameter Suffix None

Description Delete all segments. The command can only be used in program mode.

Examples Command

:TRAC:DEL:ALL

:TRACe[1|2]:FREE[?]

Command :TRACe[1|2]:FREE
Query :TRACe[1|2]:FREE? 

Parameters None

Parameter Suffix None

Description The query returns the amount of memory space available for waveform 
data in the following form: <bytes available>, <bytes in use>, < contiguous 
bytes available>.

Examples Query

:TRAC:FREE?

:TRACe[1|2]:IMPort[?]

Command :TRACe[1|2]:IMPort 
<segment_id>,<file_name>,BIN[,ALENgth|FILL|[,<dac_val
ue>]]

Query :TRACe[1|2]:IMPort?
Parameters <segment_id>,<file_name>,BIN[,ALENgth|FILL|[,<dac_val

ue>]].

Parameter Suffix None

Description Use this command to import waveform data from a file.

• <segment_id> - Id of the segment must be 1

• <file_name> file name.

• <type> BIN. File format. 

• <padding> ALENgth|FILL.

• <dac_value> a DAC value in binary format

Examples :TRAC1:IMP 1, "C:\Program Files (x86)\Keysight\M8121\
Examples\WaveformDataFiles\Sin1MHzAt7p68GHz.bin", BIN
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:TRACe[1|2]:IQIMport[?

Command :TRACe[1|2]:IQIMport 
<segment_id>,<file_name>BIN|IQBIN,IONLy|QONLy|BOTH,ON
|OFF|1|0,[,ALENgth|FILL|[,<init_valueI>[,<init_valueQ
> [,<ignore_header_parameters>]]

Query :TRACe[1|2]:IQIMport?
Parameters <segment_id>,<file_name>BIN|IQBIN,IONLy|QONLy|BOTH,ON

|OFF|1|0,[,ALENgth|FILL|[,<init_valueI>[,<init_valueQ
>[,<ignore_header_parameters>]]

Parameter Suffix None

Description Import segment data from a file. Different file formats are supported. This 
can be used to import real waveform data as well complex I/Q data.

Examples Command

:TRAC1:IQIM 1, "C:\Program Files (x86)\Keysight\
M8121\Examples\WaveformDataFiles\
Sin1MHzAt7p68GHz.bin", BIN, IONLY, ON, ALEN

:TRACe[1|2]:NAME[?] 

Command :TRACe[1|2]:NAME <segment_id>,<name>
Query :TRACe[1|2]:NAME?

Parameters <segment_id>,<name>
Parameter Suffix None

Description This command associates a name to a segment. The query gets the name 
for a segment.

<segment_id> – Id of the segment must be 1

<name> – string of at most 32 characters

Examples Command

:TRAC:NAME 1,”ADY”
Query

:TRAC:NAME? 1
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:MMEMory Commands

:MMEMory:CATalog?

Query :MMEMory:CATalog?
Parameters None

Parameter Suffix None

Description This query returns the disk usage information (drive capacity, free space 
available) and obtain a list of files and directories in a specified directory in 
the following format:

<numeric_value>,<numeric_value>,{<file_entry>}
This query returns two numeric parameters and as many strings as there 
are files and directories. The first parameter indicates the total amount of 
storage currently used in bytes. The second parameter indicates the total 
amount of storage available, also in bytes. The <file_entry> is a string. 
Each <file_entry> indicates the name, type, and size of one file in the 
directory list:

<file_name>,<file_type>,<file_size>
As the Windows file system has an extension that indicates file type, 
<file_type> is always empty. <file_size> provides the size of the file in 
bytes. In case of directories, <file_entry> is surrounded by square brackets 
and both <file_type> and <file_size> are empty.

Examples Query

:MMEM:CAT?

NOTE
MMEM commands requiring <directory_name> assume the current 
directory if a relative path or no path is provided. If an absolute path is 
provided, then it is ignored.
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:MMEMory:CDIRectory[?]

Command :MMEMory:CDIRectory [<directory_name>]
Query :MMEMory:CDIRectory?

Parameters None

Parameter Suffix None

Description This command changes the default directory for a mass memory file 
system. The <directory_name> parameter is a string. If no parameter is 
specified, the directory is set to the *RST value. At *RST, this value is set 
to the default user data storage area, that is defined as 
System.Environment.SpecialFolder.Personal

e.g. C:\Users\Name\Documents
MMEMory:CDIRectory? — Query returns full path of the default 
directory.

Examples Command

:MMEM:CDIR “C:\Users\Name\Documents”
Query

:MMEM:CDIR?

:MMEMory:COPY

Command :MMEMory:COPY <string>,<string>[,<string>,<string>] 
<string>,<string>

Parameters <string>,<string>[,<string>,<string>] 
<string>,<string>

Parameter Suffix None

Description This command copies an existing file to a new file or an existing directory 
to a new directory. Two forms of parameters are allowed. The first form has 
two parameters. In this form, the first parameter specifies the source, and 
the second parameter specifies the destination.

The second form has four parameters. In this form, the first and third 
parameters specify the file names. The second and fourth parameters 
specify the directories. The first pair of parameters specifies the source. 
The second pair specifies the destination. An error is generated if the 
source doesn't exist or the destination file already exists.
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Examples Command

:MMEM:COPY "C:\data.txt", "C:\data_new.txt"

:MMEMory:DATA?

Query :MMEMory:DATA? <file_name>
Parameters <file_name>

Parameter Suffix None

Description The query form is MMEMory:DATA? <file_name> with the response 
being the associated <data> in block format.

Examples Query

:MMEM:DATA? "C:\data.txt"

:MMEMory:DATA

Command :MMEMory:DATA <file_name>, <data>
Parameters <file_name>, <data>

Parameter Suffix None

Description The command form is MMEMory:DATA <file_name>,<data>. It loads 
<data> into the file <file_name>. <data> is in 488.2 block format. 
<file_name> is string data.

Examples Command

:MMEM:DATA “C:\data.txt”, #14test

:MMEMory:DELete

Command :MMEMory:DELete <file_name>[,<directory_name>]
Parameters <file_name>

Parameter Suffix None

Description This command removes a file from the specified directory. The 
<file_name> parameter specifies the file to be removed.

Examples Command

:MMEM:DEL "C:\data.txt"
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:MMEMory:MDIRectory

Command :MMEMory:MDIRectory <directory_name>
Parameters <directory_name>

Parameter Suffix None

Description This command creates a new directory. The <directory_name> 
parameter specifies the name to be created.

Examples Command

:MMEM:MDIR "C:\data_dir"

:MMEMory:MOVE

Command :MMEMory:MOVE <string>,<string>[,<string>,<string>]
Parameters <string>,<string>

Parameter Suffix None

Description This command moves an existing file to a new file or an existing directory 
to a new directory. Two forms of parameters are allowed. The first form has 
two parameters. In this form, the first parameter specifies the source, and 
the second parameter specifies the destination.

The second form has four parameters. In this form, the first and third 
parameters specify the file names. The second and fourth parameters 
specify the directories. The first pair of parameters specifies the source. 
The second pair specifies the destination. An error is generated if the 
source doesn't exist or the destination file already exists.

Examples Command

:MMEM:MOVE "C:\data_dir","C:\newdata_dir"
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:MMEMory:RDIRectory

Command :MMEMory:RDIRectory <directory_name>
Parameters <directory_name>

Parameter Suffix None

Description This command removes a directory. The <directory_name> parameter 
specifies the directory name to be removed. All files and directories under 
the specified directory are also removed.

Examples Command

:MMEM:RDIR "C:\newdata_dir"

:FORMat Subsystem

:FORMat:BORDer NORMal|SWAPped

Command :FORM:BORD[?]
Long :FORMat:BORDer[?]

Parameters NORMal|SWAPped
Parameter Suffix None

Description Byte ORDer. Controls whether binary data is transferred in normal (“big 
endian”) or swapped (“little endian”) byte order. Affects 
[:SOURce]:SEQuence:DATA, [:SOURce]:STABle:DATA and TRACe:DATA.

Examples Command

:FORM:BORD NORM
Query

:FORM:BORD?
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:CaLibrate Commands

The :CALibrate commands are used to control the latency from the 
M8131A digitizer to the M8121A AWG. This set of commands should be 
used only when controlling both instruments. The end effect is that the 
delay from the analog input of the digitizer to the analog output of the 
AWG is a fixed latency for a given setup. The calibration procedure must 
be run upon a change in conditions, such as a disruption to the data flow 
over ODI, change in cables, or a change in clock source.

:CALibrate:SYNC:INPut:LEVel

Command :CAL:SYNC:INP:LEV <level>

Query :CAL:SYNC:INP:LEV?

Parameters <level>|MINimum|MAXimum|DEFault

Parameter Suffix None

Description Set or query the Sync input threshold in Volts.

The Sync Input is used with the M8131A digitizer to calibrate a 
deterministic latency from analog input to analog output.

Examples :CALibrate:SYNC:INPut:LEVel 0.4

:CALibrate:LATency:LCMP

Command :CALibrate:LATency:LCMP <lcmp_value>

Parameters <lcmp_value>

Parameter Suffix None

Description Lowest common multiplier between the internal clocks of the M8131A and 
M8121A. Use value of 5 when operating with a M8131A digitizer.

Examples :CALibrate:LATency:LCMP 5
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:CALibrate:LATency[:STEP] ARM | ADJust | STOP

Command :CALibrate:LATency ARM | ADJust | STOP

Parameters STOP: default value

ARM: Arms the deterministic latency mechanism. Must be sent before the 
source (i.e. M8131A) sends sync pulses or ODI data

ADJust: Performs deterministic latency adjustment procedure. Requires 
ARM to have been previously sent, and expects that the source (i.e. 
M8131A) is in appropriate mode before this command is sent.

Parameter Suffix None

Description This command executes a step in the latency calibration of the data path 
between M8131A digitizer (master) and M8121A AWG (slave). In a 2 
channel AWG, affects both channels if enabled. If both channels can be 
successfully calibrated, then they will be adjusted to ensure that they use 
the same latency i.e. :CALibrate:LATency:VALue applies to both channels. 
The status of each channel can be checked using 
:CALibrate:LATency:STATus{1|2}?

Examples :CAL:LAT ARM

:CALibrate:LATency:VALue

Command :CALibrate:LATency:VALue <value> | MINimum | MAXimum

Query :CALibrate:LATency:VALue?

Parameter <value> | MINimum | MAXimum

Description Use :CALibrate:LATency:VALue? to query the current value of 
Deterministic Latency in seconds. This value is set during the Deterministic 
Latency ADJustment phase, and maybe subsequently modified by the 
user.

A value of 9.91E37 indicates that deterministic latency adjustment has 
either not yet been performed, has failed to complete, or has become 
invalid. Since  :CALibrate:LATency[:STEP] ADJust acts on both channels, 
and sets the latency to the same value for both channels, the value 
returned by :CALibrate:LATency:VALue? is the same for both channels. 

After Deterministic Latency Calibration has been successfully run, the 
range can be queried using CALibrate:LATency:VALue? MINimum | 
MAXimum. The results from this query are only valid if 
CALibrate:LATency:VALue? is not 9.91E37. The MINimum value is the 
value determined during the Deterministic Latency ADJustment phase. 
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The MAXimum value is the maximum deterministic latency that can be set. 
The value depends on the system configuration and the internal 
adjustments used during deterministic latency adjustment.  Note - these 
limits are recalculated after each Deterministic Latency ADJustment 
phase. If deterministic latency is invalid, the MINimum and MAXimum 
results are not useful and are set to 0 and 9.91E37.

After getting the latency range, the latency can be set using 
CALibrate:LATency:VALue <value> | MINimum | MAXimum, where <value> 
is in seconds. The value must be between the MIN and MAX limits, and is 
subject to rounding to step sizes determined by the M8121A configuration. 
The resolution is limited to sample clock periods (125ps @ 8GHz when 
operating with the M8131A) when using a reduced noise floor or LPN 
clock. Otherwise, the resolution is the same as the fine delay setting. After 
setting this value, the user may read the value as used by the M8121A 
using :CALibrate:LATency:VALue?. Note that there could be a difference in 
~40 ns in reported minimum latency after calibration. If it is desired to have 
a fixed latency each time the system is calibrated, use this command to 
explicitly set the latency to be larger than the largest minimum reported 
after multiple calibrations.

Validity: This command applies after the value has been set during the 
Deterministic Latency ADJustment phase, and until the value is reset 
automatically during the next Deterministic Latency ADJustment phase, or 
when Deterministic Latency becomes invalid. Error -221 “Settings conflict” 
is generated if this command is sent while the current value is 9.91E37 
(Deterministic Latency not valid).

Examples Command

:CALibrate:LATency:VALue MAX

Query

:CALibrate:LATency:VALue?
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:CALibrate:LATency:STATus{1|2}?

Query CALibrate:LATency:STATus{1|2}?

Parameter Suffix None

Description This query returns status of deterministic latency calibration for the 
specified channel.

Returns 1 if deterministic latency adjustment is currently valid, and 0 if 
deterministic latency adjustment has either not yet been performed, has 
failed to complete, or has become invalid.

Examples CALibrate:LATency:STATus?
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:ODI Commands

The :ODI commands are documented in the AXIe standard document 
(http://www.axiestandard.org/odispecifications.html). Please refer to the 
AXIe standard documentation for details on these commands. The 
following is a listing of the :ODI commands supported by the M8121A: 

:ODI:PORT[N]:ACTivate
:ODI:PORT[N]:CAPability:DIRection?
:ODI:PORT[N]:CAPability:FCONtrols?
:ODI:PORT[N]:CAPability:NAME?
:ODI:PORT[N]:CAPability:RATes?
:ODI:PORT[N]:CAPability:RBMax?
:ODI:PORT[N]:CAPability:TBMax?
:ODI:PORT[N]:CAPability:TRMatch?
:ODI:PORT[N]:CAPability:VERSion?
:ODI:PORT[N]:NAME?
:ODI:PORT[N]:DEACtivate
:ODI:PORT[N]:PSTatistics:BBURrsts?
:ODI:PORT[N]:PSTatistics:RBYTes?
:ODI:PORT[N]:PSTatistics:TBYTes? 
:ODI:PORT[N]:PSTatistics:THOFfs?
:ODI:PORT[N]:CSTatus?
:ODI:PORT:COUNt?
:ODI:CONSumer[N]:ACTivate
:ODI:CONSumer[N]:CAPability:CLIDs?
:ODI:CONSumer[N]:CAPability:LFILter?
:ODI:CONSumer[N]:CAPability:NAME?
:ODI:CONSumer[N]:CAPability:PFORmats?
:ODI:CONSumer[N]:CAPability:VERSion?
:ODI:CONSumer[N]:CAPability:MAXPacket?

http://www.axiestandard.org/odispecifications.html
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:ODI:CONSumer[N]:CAPability:TIMestamp:TFORmats?
:ODI:CONSumer[N]:DEACtivate
:ODI:CONSumer[N]:NAME?
:ODI:CONSumer[N]:IFSupported?
:ODI:CONSumer:ASTReam <name>, <dataDestination>, 
<sourcePorts>, <options>
:ODI:CONSumer:DESTination?
:ODI:CONSumer:RSTReam
:ODI:CONSumer:COUNt?
:TEST:ODI:PORT[1:2]:TRANsmitter[:STATe] 0|OFF|1|ON

:TEST:ODI:PORT[1:2]:TRANsmitter[:STATe] 0|OFF|1|ON

Command :TEST:ODI:PORT[1:2]:TRANsmitter[:STATe] 0|OFF|1|ON

Query :TEST:ODI:PORT[1:2]:TRANsmitter[:STATe]?

Parameters OFF|ON

Parameter Suffix None

Description This command turns on/off the ODI test source (from waveform memory). 
This is useful for debugging the ODI interface such as during 
interoperability testing.

Examples :TEST:ODI:PORT:TRAN ON
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Performance Specification

The performance specification can be found in the Data Sheet of the 
M8121A at: http://www.keysight.com/find/M8121A.

Operating Environment

Storage Temperature −40 °C to +70 °C

Operating Temperature 0 °C to 40 °C

Maximum Relative Humidity
(Non-condensing)

95% RH up to 40 °C

Operating Altitude Up to 2000 m

Installation Category II

Pollution Degree 2
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Regulatory Information 

EMC: Complies with the essential requirements of the European EMC 
Directive as well as current editions of the following standards (dates and 
editions are cited in the Declaration of Conformity):

• IEC/EN 61326-1

• CISPR Pub 11, Group 1, class A

• AS/NZS CISPR 11

• ICES/NMB-001

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

SAFETY: Complies with the following standard (dates and editions are 
cited in the Declaration of Conformity): IEC/EN 61010-1 

Acoustic statement: (European Machinery Directive)

Acoustic noise emission 

LpA <70 dB 

Operator position

Normal operation mode per ISO 7779 

To find a current Declaration of Conformity for a specific Keysight product, 
go to: http://www.keysight.com/go/conformity

WARNING
The instrument is not designed for outdoor use. Do not expose the 
instrument to rain or other excessive moisture. Protect the instrument 
from humidity and temperature changes, which could cause 
condensation within the instrument.

Do not operate the instrument in the presence of flammable gases, 
fumes or powders. Operation of any electrical instrument in such an 
environment constitutes a definite safety hazard.

NOTE
The Class 1 laser is safe to operate under reasonably foreseeable 
conditions. The user of this instrument is expected to have experience in 
safety operating products containing lasers.
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Environmental Information 

Samples of this product have been type tested in accordance with the 
Keysight Environmental Test Manual and verified to be robust against the 
environmental stresses of Storage, Transportation and End-use; those 
stresses include but are not limited to temperature, humidity, shock, 
vibration, altitude and power line conditions. 

Test Methods are aligned with IEC 60068-2 and levels are similar to 
MIL-PRF-28800F Class 3.

General

Power consumption 190 W (nom)

Safety complies with IEC/EN 61010-1

EMC tested to IEC61326

Warm-up time 30 min

Calibration interval 2 years recommended

Cooling 
Requirements

Do NOT block vents and fan exhaust. To ensure adequate cooling and ventilation, leave a gap of at least 
50 mm (2") around vent holes on both sides of the chassis. 
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